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Preface

About This Guide

This guide is intended for network and system administrators who are responsible for installing and securing
the various components of an RSA® Authentication Manager deployment.

For a complete list of documentation, see "RSA SecurID Access Product Documentation" on RSA Link at
https://community.rsa.com/docs/DOC-60094.

For a description of common RSA Authentication Manager terms, see the "RSA Authentication Manager
Glossary" on RSA Link at https://community.rsa.com/docs/DOC-76682.

RSA SecurID Access Support and Service

You can access community and support information on RSA Link at https://community.rsa.com. RSA Link
contains a knowledgebase that answers common questions and provides solutions to known problems, product
documentation, community discussions, and case management.

Support for RSA Authentication Manager
Before you call Customer Support for help with the RSA Authentication Manager appliance, have the following
information available:

l Access to the RSA Authentication Manager appliance.

l Your license serial number. To find this number, do one of the following:
l Look at the order confirmation e-mail that you received when your ordered the product. This e-
mail contains the license serial number.

l Log on to the Security Console, and click License Status. Click View Installed License.

l The appliance software version. This information is located in the top, right corner of the Quick Setup, or
you can log on to the Security Console and click Software Version Information.

Support for the Cloud Authentication Service and Identity Routers
If your company has deployed identity routers and uses the Cloud Authentication Service, RSA provides you with
a unique identifier, called the Customer Support ID, which is required when you register with RSA Customer
Support. To see your Customer Support ID, sign in to the Cloud Administration Console and clickMy Account >
Company Settings.

RSA Ready Partner Program

The RSA Ready Partner Program website at www.rsaready.com provides information about third-party hardware
and software products that have been certified to work with RSA products. The website includes
Implementation Guides with step-by-step instructions and other information on how RSA products work with
third-party products.
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Planning Decisions

Before you set up your RSA Authentication Manager deployment, you must decide which Authentication Manager
components you want to install. A deployment can include the following components:

l Primary Instance. The instance on which all administration takes place. It can also service
authentication requests.

l Replica Instance. Provides redundancy of the primary instance and authenticates users.

l Web Tiers. Allows the secure deployment of the RSA Self-Service Console, dynamic seed provisioning,
and the risk-based authentication (RBA) service within the demilitarized zone (DMZ).

l Load Balancer. Used to distribute authentication requests and to facilitate failover between the primary
and replica web tiers.

l Authentication Agents. Installed on any resource that you want to protect.

For more information on deployment planning topics, see the RSA Authentication Manager Planning Guide.

Appliance Support

RSA Authentication Manager supports a VMware virtual appliance, a Hyper-V virtual appliance, and a hardware
appliance. Each type of appliance provides the same Authentication Manager features. You can use one type of
appliance or both virtual and hardware appliances in your deployment.

Both a virtual appliance and a hardware appliance include a Linux operating system that is installed with
Authentication Manager and RSA RADIUS server software. To configure an appliance as an Authentication
Manager instance, you must complete Quick Setup.

The appliances are different from each other in the following ways:

l VMware virtual appliance:
l The VMware virtual appliance is deployed with VMware vCenter Server or the VMware ESXi
Server (VMware Hypervisor) on a host machine that you provide. You must use a host machine
that meets the hardware requirements.

l The VMware virtual appliance supports VMware features, such as VMware snapshots.

l Hyper-V virtual appliance:
l The Hyper-V virtual appliance is deployed with the Hyper-V System Center Virtual Machine
Manager (VMM) Console or the Hyper-V Manager on a host machine that you provide. You must
use a host machine that meets the hardware requirements.

l The Hyper-V virtual appliance supports Hyper-V features, such as Hyper-V checkpoints.

l Hardware appliance:
l Before performing Quick Setup, the RSA-supplied hardware appliance is deployed by directly
accessing the hardware, and connecting a keyboard and monitor to the machine to configure the
network and keyboard language settings.

l You can use PING to create a backup image of the hardware appliance in case you need to restore
the original settings for the hardware appliance. For instructions, see “Using PING to Back Up
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and Restore the RSA Authentication Manager 8.2.x Hardware Appliance” on RSA Link:
https://community.rsa.com/docs/DOC-41697.

l If a backup image is not available, you can download and install the original hardware appliance
system image from RSA Download Central at https://download.rsasecurity.com.

All of the appliance platforms provide the following:

l Pre-installed Authentication Manager software with all of the Authentication Manager features

l Pre-installed RSA RADIUS server software

l Appliance configuration through Quick Setup, a software wizard that creates access permission and
specifies whether the appliance is a primary instance or a replica instance

l SUSE Linux Enterprise Server (SLES) 11 Service Pack 4

The following Authentication Manager packages are available from RSA Download Central at
https://download.rsasecurity.com.

Required Package on RSA Download Central

New
Deployments

l For the VMware virtual appliance, download rsa-am-vmware-virtual-appliance-
8.2.1.0.0.ova.

l For the Hyper-V virtual appliance, download rsa-am-hyper-v-virtual-appliance-
8.2.1.0.0.zip.

l For the hardware appliance, the required software is included on the appliance.

Upgrades
To upgrade from version 8.2 to version 8.2 SP1, download rsa-am-update-
8.2.1.0.0.zip.

Web Tier
installation (for
new deployments
and upgrades)

Installation files are in the Extras download kit, rsa-am-extras-8.2.1.0.0.zip.

Additional
Software

The Extras download kit, rsa-am-extras-8.2.1.0.0.zip, includes additional software,
such as the RSA Authentication Manager Bulk Administration utility (AMBA) and the RSA
Authentication Manager Software Development Kit (SDK).

If you need to restore your hardware appliance to a pre-configured state, you can
download and apply rsa-am-hardware-appliance-8.2.1.0.0.iso. For instructions, see
the Help topic "Hardware Appliance System Image Installation" on RSA Link:
https://community.rsa.com/docs/DOC-59428.

VMware Virtual Appliance Requirements

If you deploy RSA Authentication Manager 8.2 Service Pack 1 on a VMware virtual appliance, use the VMware
vSphere Client to deploy a virtual appliance through VMware vCenter Server or directly on the VMware ESXi
platform (also known as VMware vSphere Hypervisor 5.5 or later). VMware vCenter Server is not required to
deploy the virtual appliance.

You must deploy a VMware virtual appliance with theRSA Authentication Manager Open Virtualization Appliance
(OVA) file that is located in the RSA Authentication Manager 8.2 Service Pack 1 download kit.

Chapter 1: Preparing for Deployment 13
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VMware Software Requirements

Required Software Description

VMware Platforms

Deploy the virtual appliance on one of the following platforms:

l VMware ESXi 5.5 (VMware vSphere Hypervisor 5.5)

l VMware ESXi 6.0 (VMware vSphere Hypervisor 6.0)

VMware vSphere Client
Any version of the vSphere Client that works with supported ESXi (Hypervisor) and
vCenter Server deployments.

For the VMware host hardware requirements, see your VMware documentation.

VMware Software Support

Supported Software Description

(Optional) VMware
vCenter Server

VMware vCenter Server provides centralized management for multiple virtual
machines and includes administrative features, such as vMotion.

The virtual appliance supports the versions of VMware vCenter Server that are
compatible with the supported ESXi versions:

l

l

VMware vCenter Server 5.5 

VMware vCenter Server 6.0

VMware Primary or Replica Instance Hardware Requirements
The virtual appliance for each RSA Authentication Manager instance requires hardware that meets or exceeds
the minimum requirements. Each instance is deployed with the default values.

Description Minimum Requirement Default Value

Disk Space
100 GB

4 GB swap file

100 GB

4 GB swap file

Memory Requirements 4 GB 8 GB

CPU Requirements One virtual CPU Two virtual CPUs

The virtual appliance may require additional disk space for virtual machine operations, such as snapshots and
memory management. Use the following formula to calculate the total amount of storage required:

Total disk space = 104 GB + (GB of memory allocated to the virtual appliance x 2) + (Number of snapshots x GB
of memory allocated to the virtual appliance)

For example, a virtual appliance with 8 GB of memory and three snapshots requires about 150 GB of storage.
The calculation 104 GB + (2 x 8 GB of memory) + (3 snapshots x 8 GB of memory) indicates that 144 GB is
required, or 150 GB if you include a 6 GB buffer.

Automatic tuning on the virtual appliance supports 4 GB, 8 GB, 16 GB, or 32 GB of memory. For example, the
appliance uses 32 GB of memory if more than 32 GB is available.

The virtual appliance only supports the E1000 virtual network adapter. Do not change the default network
adapter or add a new virtual network adapter to the virtual appliance.

For the VMware host hardware requirements, consult your VMware documentation.

For information on ports used by Authentication Manager, see Port Usage on page 107.
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VMware Feature Support
RSA Authentication Manager supports VMware features, such as vMotion, Storage vMotion, High Availability,
Fault Tolerance, Distributed Resource Scheduler (DRS), and Snapshots. Restrictions are described in the
following table.

Feature Support

VMware Fault Tolerance

VMware Fault Tolerance in VMware vSphere 5.5 has the following
requirements:

l Only virtual appliances with a single virtual CPU are compatible with
Fault Tolerance. By default, each Authentication Manager instance is
deployed with two virtual CPUs.
You can change the number of virtual CPUs. For instructions, see
the VMware vSphere Client documentation.

l VMware Fault Tolerance does not support IPv6. If you use Fault
Tolerance, do not create an IPv6 network address on an
Authentication Manager primary or replica instance.

VMware snapshots

You can take a VMware snapshot of an Authentication Manager primary or
replica instance, but snapshots do not replace the Operations Console
backup feature.

When you take a snapshot of an Authentication Manager instance, specific
settings are required. In a complex Authentication Manager deployment,
restoring snapshots requires you to perform additional tasks.

For more information, see the RSA Authentication Manager Administrator's
Guide.

VMware Distributed Resource
Scheduler (DRS)

For security and redundancy, you can install primary and replica instances
on separate hosts.

VMware DRS can move both instances onto the same host. Configure DRS
to keep instances on separate physical hosts.

Hyper-V Virtual Appliance Requirements

If you deploy RSA Authentication Manager 8.2 Service Pack 1 on a Hyper-V virtual appliance, use the Microsoft
Hyper-V System Center Virtual Machine Manager (VMM) Console or the Hyper-V Manager.

Deploy a Hyper-V virtual appliance with the RSA Authentication Manager Hyper-V virtual appliance zip file that is
available from RSA Download Central at https://download.rsasecurity.com.

Hyper-V Software Requirements

Required Software Description

Windows Servers
l Microsoft Windows 2012 R2 host machine

l Microsoft Windows 2012 host machine

Hyper-V Management
Tools

Deploy the Hyper-V virtual appliance with one of the following tools:

l Hyper-V System Center 2012 R2 or 2012 Virtual Machine Manager (VMM).

l Hyper-V Manager 2012 R2 or 2012.

Chapter 1: Preparing for Deployment 15
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Required Software Description

PowerShell

Windows PowerShell 4.0 or later is required.

If you are using Hyper-V System Center 2012 R2 VMM, use the Windows PowerShell
version that is included with the VMM Console installation.

If you are using Hyper-V Manager 2012 R2, use the Windows PowerShell version that
is included with Windows 2012 R2.

Hyper-V Virtual Machine
Manager (VMM) Modules

If you are using VMM, then install the VMM Console to obtain the required Virtual
Machine Manager Windows PowerShell module.

To verify that the required Hyper-V and VirtualMachineManager PowerShell modules
are available, run these two PowerShell commands:

Get-Command -Module Hyper-V

Get-Command -Module VirtualMachineManager

The output displays a list of commands related to each module.

For more information, see your Hyper-V documentation.

Hyper-V Manager
Software

If you are using Hyper-V Manager, then install both the Hyper-V role and the
management tools. For example, if you use Server Manager to install the Hyper-V role,
the management tools are included by default.

For instructions, see your Hyper-V documentation.

For the Hyper-V host hardware requirements, see your Hyper-V documentation.

Hyper-V Primary or Replica Instance Hardware Requirements
The virtual appliance for each RSA Authentication Manager instance requires hardware that meets or exceeds
the minimum requirements.

Description Minimum Requirement Default Value

Disk Space
100 GB storage

4 GB swap file

100 GB storage

4 GB swap file

Memory Requirements 4 GB 8 GB

CPU Requirements One virtual CPU Two virtual CPUs

The virtual appliance may require additional disk space for virtual machine operations, such as checkpoints and
memory management. For example, you may need 150 GB in total storage, or you may need 200 GB in total
storage if you are using 16 GB of memory.

Automatic tuning on the virtual appliance supports 4 GB, 8 GB, 16 GB, or 32 GB of memory. For example, the
appliance uses 32 GB of memory if more than 32 GB is available.

The Hyper-V virtual appliance provides a virtual network adapter that uses the hv_netvsc driver. Do not use the
legacy network adapter. The legacy network adapter is not supported.

For the Hyper-V host hardware requirements, consult your Hyper-V documentation.

For information on ports used by Authentication Manager, see Port Usage on page 107.

Hyper-V Feature Support
RSA Authentication Manager supports Hyper-V features, such as live migration, high availability through
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failover clustering, NIC teaming for virtual machines, and checkpoints. Restrictions are described in the
following table.

Feature Support

Dynamic memory
Dynamic memory is not supported for the Hyper-V virtual appliance. Static memory is
supported. For more information on memory requirements, see Hyper-V Primary or
Replica Instance Hardware Requirements on the previous page.

Hyper-V checkpoints

You can create a Hyper-V checkpoint for an Authentication Manager primary or replica
instance, but checkpoints do not replace the Operations Console backup feature.

In a complex Authentication Manager deployment, restoring a virtual machine to a
checkpoint requires you to perform additional tasks.

For information, see the RSA Authentication Manager Administrator's Guide.

Hyper-V high availability

For security and redundancy, you can install primary and replica instances on
separate hosts.

Hyper-V live migration can move both instances onto the same host. Configure high
availability to use availability sets to keep instances on separate physical hosts.

Supported Data Stores

You can store data in:

l The RSA Authentication Manager internal database

l One or more external directory servers that use LDAP (called an identity source within Authentication
Manager).

Internal Database
RSA Authentication Manager is installed with an internal database. The following information is stored only in
the internal database:

l Data that is specific to Authentication Manager, such as token data or policies for administrative roles
and passwords.

l Data that links Authentication Manager with LDAP directory user and user group records.

Users, user groups, and identity attribute data can be stored in an external LDAP directory or in the internal
database.

Supported Directory Servers
RSA Authentication Manager supports the following external LDAP directory servers for user, user group, and
identity attribute data:

l

l

l

l

l

Microsoft Active Directory 2008 R2

Microsoft Active Directory 2012

Microsoft Active Directory 2012 R2

Microsoft Active Directory Lightweight Directory Services 2012 R2

Microsoft Active Directory 2016

Sun Java System Directory Server 7.0

Chapter 1: Preparing for Deployment 17
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l Oracle Directory Server Enterprise Edition 11g

l OpenLDAP 2.4.40

In Active Directory, you can add a Global Catalog as an identity source, which is used to look up users and
resolve group membership during authentications. You cannot use a Global Catalog identity source to perform
administrative tasks.

Note: Authentication Manager supports Active Directory Lightweight Directory Services (LDS) servers if the
same server does not also have an Active Directory Domain Controller role. If a server has an Active Directory
Domain Controller role, select that identity source type when connecting the identity source to Authentication
Manager.

Authentication Manager has read-only access to all external directory servers. However, you can configure the
system to allow users to change their passwords in LDAP during authentication.

Authentication Manager LDAP integration does not modify your existing LDAP schema, but rather creates a map
to your data that Authentication Manager uses.

Authentication Manager supports Secure Socket Layer (SSL) for LDAP connections. SSL is required if you are
allowing users to change their passwords from Authentication Manager. Non-SSL connections can expose
sensitive data as it passes over the connection. For example, if bind LDAP operations to authenticate are
performed over a non-SSL connection, the password is sent in the clear. The use of LDAP over SSL requires that
the appropriate certificate is accessible by Authentication Manager.

For more information, see the chapter “Integrating LDAP Directories” in the RSA Authentication Manager
Administrator’s Guide.

Supported Web Browsers

RSA Authentication Manager administration is managed through a web-based interface and must be accessed
through a supported browser. Authentication Manager supports the following web browsers:

l Microsoft Internet Explorer 9.0 or later

l Mozilla Firefox 27.0 or later

l Google Chrome 18 or later

l Apple Safari 5.1

The web browser must allow JavaScript and cookies. If your web browser does not have JavaScript and cookies
enabled, see your web browser documentation for instructions on enabling JavaScript and cookies. You must
select browsers that support the SSL protocols and ciphers that are compatible with your Authentication
Manager deployment.

Note: To correctly display the web-based interface, you must have a screen resolution of 1024 X 768 or
higher.

Supported RSA Authentication Agents

Authentication agents are software applications that securely pass user authentication requests to and receives
responses from RSA Authentication Manager. Authentication agents are installed on each machine, such as a
domain server, web server, or a personal computer, that you protect with Authentication Manager. Any resource
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that is used with SecurID authentication, on-demand authentication (ODA) or risk-based authentication (RBA)
requires an authentication agent.

The agent that you need depends on the type of resource you want to protect. For example, to protect an Apache
web server, you need to download the RSA Authentication Agent for Apache. You may purchase products that
contain embedded RSA Authentication Agent software. For example, these products include all the major brands
of remote access servers and firewalls.

For a list of RSA authentication agents, go to http://www.emc.com/security/rsa-securid/rsa-securid-
authentication-agents.htm#!offerings.

For a list of third-party products that have embedded RSA agents, go to the The RSA Ready Partner Program
website at www.rsaready.com.

For more information, see the Help topic "Deploying an Authentication Agent".

RSA Authentication Manager License Support

RSA Authentication Manager is provided with the RSA SecurID Access Base Edition, Enterprise Edition, and
Premium Edition licenses. For more information about what is included in each license level, see “RSA SecurID
Access License Options” at https://community.rsa.com/docs/DOC-75836.

For RSA Authentication Manager 8.0 or later, earlier licenses can be used with later versions of Authentication
Manager, but later licenses cannot be used with earlier versions of Authentication Manager. For example,
installing or upgrading RSA Authentication Manager 8.2 SP1 requires an existing version 8.0 or later license, a
new version 8.2 SP1 license, or any combination of these licenses. Authentication Manager supports stackable
licenses that allow you to add users and authenticators to your existing license.

Authenticators include hardware tokens, software tokens, and the RSA SecurID Authenticate app. When
Authentication Manager users successfully authenticate with the Authenticate app, their user records are
updated with the app. The Authenticate app counts as an active token for licensing purposes.

Each license includes the following Authentication Manager features:

l A specific number of tokens (authenticators).

l Self-Service

l Authenticator workflow provisioning

l RADIUS

l Offline authentication

A license can include the following optional features:

l On-demand authentication (ODA)

l Risk-based authentication (RBA)

l Business continuity

It is important to know:

l You can install multiple licenses.

l The Account ID must be the same for all licenses.

l The License ID (or Stack ID), must be unique for each license. You cannot install the same license twice.

Chapter 1: Preparing for Deployment 19

http://www.emc.com/security/rsa-securid/rsa-securid-authentication-agents.htm#!offerings
http://www.emc.com/security/rsa-securid/rsa-securid-authentication-agents.htm#!offerings
https://www.rsa.com/en-us/partner/rsa-ready-program.html
https://community.rsa.com/docs/DOC-75836


RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

l Users only count against the license limit if they have one or more assigned authenticators. Users
without authenticators do not count against the limit.

l Each assigned token used to access agent-protected resources counts against the license limit. For
example, a user who authenticates with a hardware token and the Authenticate app is considered to
have two tokens for licensing purposes.

l The Security Console displays warning messages when you exceed 85, 95, and 100 percent of the user
limit.

l The system updates the user counts every hour and each time that a user views the license status in the
Security Console.

RSA provides the license files separately from your RSA Authentication Manager download kit. Make sure that
you know the location of the license file before running the primary appliance Quick Setup. The license file must
be accessible to the browser that is used to run the primary appliance Quick Setup. Do not unzip the license file.

Accurate System Date and Time Settings

RSA Authentication Manager requires accurate date and time settings for replication and authentication. If the
token clock and the Authentication Manager system clock do not match, the generated tokencodes will not
match, and authentication attempts can fail. Specifying a Network Time Protocol (NTP) server for the instance
prevents replication and authentication issues that are caused by clock drift.

Note: An NTP server is required in a replicated deployment. RSA requires that all Authentication Manager
instances have their time synchronized to an NTP server.

If you do not specify an NTP server in Authentication Manager, the virtual appliance uses the date and time
provided by the physical machine hosting the virtual appliance. In this situation, the physical machine hosting
the virtual appliance should be configured to obtain accurate date and time information from an NTP server.

Make sure that you have the hostname or IP address of an NTP server before running Quick Setup.

Secure Appliance Deployment

After you deploy RSA Authentication Manager on a hardware appliance or a virtual appliance, the operating
system console screen displays a Quick Setup Access Code along with a Quick Setup URL. The Quick Setup
Access Code is only available until Quick Setup is complete.

The Quick Setup Access Code is required to begin Quick Setup, which configures the appliance as an RSA
Authentication Manager instance. This code makes it harder for a malicious user to access Quick Setup and take
control of the appliance.

Note: You must have the Quick Setup Access Code to begin Quick Setup.

RSA recommends the following guidelines when deploying an appliance:

l Deploy a hardware appliance in a test environment or in an isolated network. Only connect the appliance
to your organization’s network after Quick Setup is complete. Restrict physical and network access to the
appliance to authorized individuals.
For example, you can deploy a hardware appliance and run Quick Setup in a protected test environment
that duplicates your production environment. After Quick Setup is complete, you can move the appliance
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into the production environment without changing the network settings, such as the hostname and the
IP Address.
Alternately, you can deploy the hardware appliance and run Quick Setup in a protected test environment
and later change the network settings, such as the hostname and IP address, to attach the appliance to
your production environment. For more information, see the Help topic “Primary or Replica Instance
Network Settings Updates.”

l Deploy a VMware or Hyper-V virtual appliance on an isolated network until Quick Setup is complete. Use
VMware or Hyper-V to maintain full control over the appliance. Restrict network access to the appliance,
and only allow authorized individuals to access the virtual appliance.

l If you access an appliance to run Quick Setup, and you discover that the appliance has already been
configured or you receive error messages because Quick Setup is in progress, then do the following:

a. Contact other administrators in your organization to ensure that a malicious user is not trying to
take control of the appliance.

b. If you believe that the appliance has been compromised, remove the primary or replica instance
from your deployment. For instructions, see the RSA Authentication Manager Administrator's
Guide.

c. Do one of the following:
l For a hardware appliance, shut down the appliance and remove the machine from
service.

l For a virtual appliance, suspend the appliance, and quarantine the machine for further
investigation.

d. Contact your IT department or RSA immediately.

Deployment Checklist for the Primary Replica Instance

Before you set up the RSA Authentication Manager primary instance or the replica instance, you must collect the
following information. You enter this information during the appliance deployment and Quick Setup.

VMware Virtual Appliance Deployment
If you are deploying RSA Authentication Manager on a virtual appliance, you must collect the following items and
information:

VMware vSphere Client computer. You will use this computer to deploy the appliance through the
VMware vSphere Client. Use this computer to run Quick Setup through a supported web browser. For a list
of supported web browsers, see Supported Web Browsers on page 18.

RSA Authentication Manager Open Virtualization Appliance (OVA)  file. The RSA Authentication
Manager OVA file is used to create your virtual appliance. Copy the OVA file to a location accessible to
VMware.

IPv4 Network settings. Identify the fully qualified domain name and static IP address for the appliance,
the subnet mask and default gateway, and the IP address or hostname of the DNS servers in the
network.You must provide this network information when deploying the appliance. The IP address that you
specify for the appliance is used to access Quick Setup.

Hyper-V Virtual Appliance Deployment
If you are deploying RSA Authentication Manager on a virtual appliance, you must collect the following items and
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information:

Microsoft Windows client computer with access to a Microsoft Windows 2012 or 2012 R2
Hyper-V host machine. Use Remote Desktop Protocol or direct access to log on to the Microsoft Windows
2012 or 2012 R2 Hyper-V host machine. You can deploy the appliance through either the Hyper-V Virtual
Machine Manager (VMM) Console or the Hyper-V Manager.
You will also use the Microsoft Windows client computer to run Quick Setup through a supported web
browser. For a list of supported web browsers, see Supported Web Browsers on page 18.

RSA Authentication Manager virtual appliance zip file. The RSA Authentication Manager Hyper-V
virtual appliance zip file is used to deploy your virtual appliance. Copy the file to a location accessible to
Hyper-V. For VMM deployment, copy the file to an existing Hyper-V VMM library server or a shared folder
on a Microsoft Windows 2012 or 2012 R2 machine that can be added as a library server. For Hyper-V
Manager deployment, copy the file to a location on the Microsoft Windows 2012 or 2012 R2 Hyper-V host
machine.

IPv4 Network settings. Identify the fully qualified domain name and static IP address for the appliance,
the subnet mask and default gateway, and the IP address or hostname of the DNS servers in the network.
You must provide this network information when deploying the appliance. The IP address that you specify
for the appliance is used to access Quick Setup.

Hardware Appliance Deployment
If you are deploying RSA Authentication Manager on a hardware appliance, you must collect the following items
and information:

Keyboard and Monitor. To deploy the hardware appliance and complete the initial configuration tasks
that are required for the deployment process, you must attach a keyboard and monitor to the appliance.

IPv4 Network settings. Identify the fully qualified domain name and static IP address for the appliance,
the subnet mask and default gateway, and the IP address or hostname of the DNS servers in the network.
You must provide this network information when deploying the appliance. The IP address that you specify
for the appliance is used to access Quick Setup.

Quick Setup Checklist for the Primary Instance
You must enter the following information during the Quick Setup process for a primary instance.

Appliance license file. During Quick Setup, you must have access to the .zip license file. You download
the license file (.zip) from RSA Download Central at
https://download.rsasecurity.com.

Use the credentials that were e-mailed to you to log on to the site and download the license file. If you did
not receive this e-mail, contact the License Seed Response Team. Send an e-mail with your contact
information and the license serial number provided in your order confirmation to the following address
appropriate for your region:

l Americas: license_seed_response@rsa.com

l EMEA: support@rsa.com.

l Asia Pacific: support@rsa.com

Make sure that you know the location of the license file before running the primary appliance Quick Setup.
The license file must be in a location that is accessible to the browser that is used to run the primary
appliance Quick Setup. Do not unzip the file. RSA recommends that you store the license file in a protected
location available only to authorized administrative personnel.
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Hostname or IP address of an NTP server. RSA recommends that you specify a local or Internet
Network Time Protocol (NTP) server, for example, nist.time.gov. During Quick Setup, you can enter the
hostname or IP address of at least one NTP servers.

Note: An NTP server is required in a replicated deployment. RSA requires that all Authentication
Managerinstances have their time synchronized to an NTP server.

Operating system password. Choose a password to access the appliance operating system for
troubleshooting and advanced administration. The password must be between 8 and 32 characters long,
and contain at least 1 alphabetic character and at least 1 special character excluding ^, @, and ~. For
example, gyz!8kMh is a valid password. For more information, see System Administrator Accounts on
page 116.

User ID and password for initial administrator accounts.Choose a User ID and password to create
the following:

l Initial Security Console administrator User ID and password for the Super Admin role

l Operations Console administrator User ID and password

For information on managing administrator accounts and passwords, see System Administrator Accounts
on page 116.

Quick Setup Checklist for the Replica Instance
You must enter the following information during the Quick Setup process for a replica instance.

Replica package file location. To set up a replica appliance, you must have access to the replica
package file. If necessary, copy the replica package file onto the computer that you will use to run Quick
Setup.

For more information on creating a replica package, see Generate and Download a Replica Package File on
page 44.

Hostname or IP address of an NTP server. You must synchronize the time on the primary and replica
appliances using a local or Internet Network Time Protocol (NTP) server. During Quick Setup, you can
enter hostname or IP address of at least one NTP server.

Operating system password. Choose a password to access the appliance operating system for
troubleshooting and advanced administration. The password must be between 8 and 32 characters long,
and contain at least 1 alphabetic character and at least 1 special character excluding ^, @, and ~. For
example, gyz!8kMh is a valid password. Choose a unique password for each appliance. For more
information, see System Administrator Accounts on page 116.

Setup and Configuration Information List

Use the following list to specify setup and configuration information for RSA Authentication Manager. RSA
recommends that you complete this list and distribute it to the appropriate personnel for your deployment. Save
a copy of the completed list in a secure location for future reference.

Note: Some of the information that you enter in this list may be sensitive. Review your company’s policies
before entering sensitive information, such as a password, in this list.

Appliance Deployment

Note: If your deployment uses IPv6-compliant agents, you can add IPv6 network settings in the Operations
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Console after Quick Setup is complete.

VMware or Hyper-V Virtual Appliance

Element Your Plan

VMware OVA package location or
Hyper-V virtual appliance zip file
location

Fully qualified domain name

IPv4 Static IP address

IPv4 Subnet mask

IPv4 Default Gateway

IP address of the DNS servers

Hardware Appliance

Element Your Plan

Fully qualified domain name

IPv4 Static IP address

IPv4 Subnet mask

IPv4 Default Gateway

IP address of the DNS servers

Primary Appliance Setup

Description Your Plan

RSA Authentication Manager license
file (.zip) location

Hostname or IP address of an NTP
server

Operating System password

Super Admin user name

Super Admin password

Operations Console Administrator user
name

Operations Console Administrator
password

Replica Appliance Setup

Description Your Plan

Replica package file location

Hostname or IP address of an NTP server

Operating system password

Load Balancer Configuration

Description Your Plan

Load balancer IP address

Load balancer hostname/virtual
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Description Your Plan

hostname

Port number

IP address of virtual host or load balancer
on the DNS server

Web Tier Installation

Description Your Plan

Location of the RSA Authentication
Manager 8.2 SP1 Extras download
kit, which contains the web-tier
installers.

Web-tier server IP addresses

Web-tier server hostnames

IP address of the DNS server
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Perform Deployment Tasks

Perform these steps to deploy an appliance and configure an RSA Authentication Manager primary instance.

Procedure

1. Deploy the appliance. Do one of the following:
l For a VMware virtual appliance, you can either Deploy the Virtual Appliance Through VMware
vCenter Server below or Deploy the Virtual Appliance Directly to the VMware ESXi Server on
page 30.

l For a Hyper-V virtual appliance, you can either Deploy the Virtual Appliance Through the Hyper-V
Virtual Machine Manager Console on page 31 or Deploy the Virtual Appliance Through the Hyper-
V Manager on page 34.

l For a hardware appliance, see Deploy the Hardware Appliance on page 36.

2. Configure the appliance with Quick Setup, a software wizard that creates access permission and
specifies whether the appliance is a primary instance or a replica instance. See Run Quick Setup on the
Primary Instance on page 37.

3. Accept the internal RSA certificate authority (CA) certificate. See Certificate Management for Secure
Sockets Layer on page 39.

4. Log On to the Consoles on page 40.

Deploy the Virtual Appliance Through VMware vCenter Server

You can deploy a virtual appliance through VMware vCenter Server, if you are using this administrative tool to
manage the virtual appliances. This process requires several minutes to complete.

Note: Depending on your VMware vCenter configuration and the version of the VMware vSphere Client, some of
the windows that are described in the following procedure may not display. The window names may also vary.

Before you begin

l Collect the required information about each appliance instance being deployed. See Secure Appliance
Deployment on page 20.

l Copy the RSA Authentication Manager Open Virtual Appliance (OVA) file to a location that the VMware
vSphere Client can access.

Procedure

1. In the VMware vSphere Client, log on to VMware vCenter Server.

2. Select File > Deploy OVF Template to start the deployment wizard.

3. On the Source window, under Deploy from a file or URL, click Browse, and locate the RSA
Authentication Manager OVA file to deploy. ClickNext.

4. On the OVF Template Details window, verify that “RSA Authentication Manager” and the expected version
number displays. ClickNext.

5. On the End User License Agreement window, scroll to read the agreement. Click Accept, and Next.
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6. On the Name and Location window, enter aName for the virtual appliance, and clickNext.

7. On the Host/Cluster window, select a host or cluster for the virtual appliance. ClickNext.

8. On the Resource Pool window, select a resource pool. Resource pools let you manage your resources
within a host or cluster. ClickNext.

9. On the Storage window, select an existing VMware datastore for the virtual machine files. A VMware
datastore can be a location such as a Virtual Machine File System (VMFS) volume, a directory on Network
Attached Storage, or a local file system path. ClickNext.

10. On the Disk Format window, select a format for storing virtual disks.

11. On the Network Mapping window, select the networks for the virtual appliance. ClickNext.

12. On the Properties window, enter the following IPv4 network settings for the virtual appliance, and click
Next:

l Fully Qualified Domain Name

l IP Address.

l Subnet Mask

l Default Gateway

l (Optional) Primary DNS Server

l (Optional) Secondary DNS Server

Note: If your deployment uses IPv6-compliant agents, you can add IPv6 network settings in the
Operations Console after Quick Setup is complete.

13. On the Ready to Complete window, review your settings, and click Finish. VMware requires
approximately five minutes to deploy the virtual appliance.

14. Power on the virtual machine.

15. Click the Launch Virtual Machine Console button.

The virtual machine console displays the progress of the virtual appliance deployment.

16. Wait for 30 seconds to select the default keyboard layout, English (United States). To select a different
keyboard layout, press any key and follow the instructions on the screen.

17. Verify that the settings are correct. To accept the settings, type y, or wait 30 seconds.

18. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the Quick
Setup Access Code. Record the following required information:

l The Quick Setup URL includes the IP address that you entered in step 12.
https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

19. Enter the Quick Setup URL in the browser, including https, and press ENTER:

https://<IP Address>/

20. If you want to confirm the authenticity of the virtual appliance, you must verify that the SHA-1
fingerprint of the certificate presented during Quick Setup matches the SHA-1 fingerprint displayed in
the OS Console.
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Deploy the Virtual Appliance Directly to the VMware ESXi Server

You can deploy a virtual appliance directly to the VMware ESXi server (VMware Hypervisor). VMware vCenter is
not required to deploy the virtual machine. This process requires several minutes to complete.

Note: Depending on your configuration of the VMware ESXi server and the version of the server, some of the
windows that are described in the following procedure may not display. The window names may also vary.

Before you begin

l Collect the required information about each appliance instance being deployed. See Secure Appliance
Deployment on page 20.

l Copy the RSA Authentication Manager Open Virtual Appliance (OVA) file to a location that the VMware
vSphere Client can access.

Procedure

1. In the VMware vSphere Client, log on to the VMware ESXi server.

2. Select File > Deploy OVF Template to start the deployment wizard.

3. On the Source window, under Deploy from a File or URL, click Browse, and locate the RSA
Authentication Manager OVA file to deploy. ClickNext.

4. On the OVF Template Details window, verify that “RSA Authentication Manager” and the expected version
number displays. ClickNext.

5. On the End User License Agreement window, scroll to read the agreement. Click Accept, and Next.

6. On the Name and Location window, enter aName for the virtual appliance, and clickNext.

7. On the Datastore window, select a directory for the virtual machine files. A VMware datastore can be a
location such as a Virtual Machine File System (VMFS) volume, a directory on Network Attached Storage,
or a local file system path. ClickNext.

8. On the Disk Format window, select a format for storing virtual disks.

9. On the Network Mapping window, select the networks for the virtual appliance. ClickNext.

10. On the Ready to Complete window, review your settings, and click Finish. VMware requires
approximately five minutes to deploy the virtual appliance.

11. Power on the virtual machine.

12. For the virtual appliance, click the Console tab.

The OS Console displays the progress of the boot sequence.

13. Wait for 30 seconds to select the default keyboard layout, English (United States). To select a different
keyboard layout, press any key and follow the instructions on the screen.

14. When you are prompted by the OS Console, enter the following IPv4 network settings for the virtual
appliance:

l Fully Qualified Hostname

l IP Address

l Subnet Mask

l Default Gateway

l (Optional) DNS Server Configuration
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Note: If your deployment uses IPv6-compliant agents, you can add IPv6 network settings in the
Operations Console after Quick Setup is complete.

15. Verify that the settings are correct. To accept the settings, type y, or wait 30 seconds.

16. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the Quick
Setup Access Code. Record the following required information:

l The Quick Setup URL includes the IP address that you entered in step 14.
https://<IP Address>/
Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

17. Enter the Quick Setup URL in the browser, including https, and press ENTER:

https://<IP Address>/

Note: If you want to confirm the authenticity of the virtual appliance, you must verify that the SHA-1 fingerprint
of the certificate presented during Quick Setup matches the SHA-1 fingerprint displayed in the OS Console.

Deploy the Virtual Appliance Through the Hyper-V Virtual Machine
Manager Console

You can deploy a virtual appliance through the Hyper-V System Center Virtual Machine Manager (VMM) Console.
RSA provides a PowerShell script that creates a virtual machine template that automatically configures the
virtual machine. You complete configuration through the Hyper-V VMM Console. This process requires several
minutes to complete.

Before you begin

l Collect the required information about each appliance instance to deploy. See Secure Appliance
Deployment on page 20.

l Copy the RSA Authentication Manager Hyper-V virtual appliance file, rsa-am-hyper-v-virtual-
appliance-8.2.1.0.0.zip, to an existing Hyper-V VMM library server or a shared folder on a Microsoft
Windows 2012 or 2012 R2 machine that can be added as a library server.

l Unzip the file to the current location.

l The contents include a Windows batch file, a PowerShell script, and two virtual hard drive (VHD) files.
The disk1 VHD file is the primary virtual hard drive that the virtual appliance uses for storage. The
disk2 VHD file is a swap drive that improves virtual appliance startup times.

Note: Do not rename the VHD files.

Procedure

1. Log on to the Microsoft Windows 2012 or 2012 R2 machine that has the Hyper-V VMM Console installed.

2. (Optional) If the disk1 and disk2 VHD files are not located on an existing library server, add the location
of the VHD files as follows:

a. Open the Hyper-V VMM Console, and log on to the VMM server.

b. On theHome tab, click Add Library Server.

c. Select or enter the library server logon credentials, and clickNext.
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d. Search for the server that contains the VHD file, select the server, and clickNext.

e. Select the share that contains the downloaded VHD file, and clickNext.

f. Select the share that contains the downloaded VHD file, and clickNext.

g. Click Add Library Servers.

3. On the Windows taskbar, right-clickWindows PowerShell, and select Run as Administrator.

4. Change directories to the location of the Windows batch file. Type the following, and press ENTER:

cd 'Windows_Directory_Path'

Where
'Windows_Directory_Path' is the location of the Windows batch file.

5. To create a Hyper-V virtual machine template, type the following, and press ENTER:

.\create_vm.bat -vmm -server FQDN_or_IP address -port port_number -libraryserver 'Windows_
Directory_Path' -templatename Template_Name

Where

l -vmmmakes the batch file run in VMM mode.

l -server FQDN_or_IP address is the fully qualified domain name or IP address of the VMM server.

l -port port_number is the optional argument for the VMM server port. If you do not specify this
option, the system uses the default value 8100.

l -libraryserver 'Windows_Directory_Path' is the location of the library server managed by the
VMM where the VHD files are uploaded.
Note: Do not specify a local folder. The -libraryserver argument must specify a library server
that is a shared location configured in the VMM server.

l -templatename Template_Name is the optional argument for the name of the template. Specify a
template name if you might run the batch file more than one time. If you do not specify a name,
the system uses the default value RSA Authentication Manager Appliance VM Template.
The template namemust contain 69 or fewer characters and follow Windows naming
conventions. For example, the filename cannot contain the characters \ / : * ? " < > and |.

For example, run .\create_vm.bat -vmm -server 192.168.0.0 -libraryserver
'\\windowshyperv.yourorganization.com\libraryshare' to create a Hyper-V virtual machine
template that uses the default port and template name.

6. If you are prompted by a security warning, type r to run the script. By default, PowerShell has a
restrictive security policy that does not trust scripts that you download from the Internet.

7. When you are prompted, enter administrative credentials for the VMM server.

After the script successfully creates the virtual machine template, you can use the Create Virtual
Machine wizard in the Hyper-V VMM Console.

8. If you have not already done so, open the Hyper-V VMM Console, and log on to the VMM server.

9. Click Library > Templates > VM Templates.

10. Right-click the name of the virtual machine template, and select Create Virtual Machine. The default
name is RSA Authentication Manager Appliance VM Template.
The Create Virtual Machine wizard launches.
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11. On the Identity window, enter a name for the virtual appliance, and clickNext.

12. On the Configure Hardware window, keep the default hardware profile, and clickNext. The PowerShell
script automatically configured the virtual machine template.

13. On the Select Destination window, select Place the virtual machine on a host, and choose a
destination. ClickNext.

14. On the Select Host window, choose a Hyper-V host as the destination for deploying the virtual appliance.
ClickNext.

15. On the Configure Settings window, choose a location to store the virtual appliance files. ClickNext.

16. On the Select Networks window, choose a network connection from the drop-down list, and clickNext.
You must connect the virtual appliance to your network before it is powered on.

17. On the Add Properties window, configure the action to take when the host machine starts or stops. You
can choose whether to prevent the virtual appliance from being migrated by Performance and Resource
Optimization. ClickNext.

18. On the Summary window, click Create.

19. After the virtual appliance is successfully created, power on the virtual appliance, and connect to the
virtual appliance through the VMM Console.

20. Wait for 30 seconds to select the default keyboard layout, English (United States). To select a different
keyboard layout, press any key and follow the instructions on the screen.

21. Read the End User License Agreement (EULA), and type yes to accept it.

22. When the OS Console prompts you, enter the following IPv4 network settings for the virtual appliance:
l Fully Qualified Hostname

l IP Address

l Subnet Mask

l Default Gateway

l (Optional) DNS Server Configuration

Note: If your deployment uses IPv6-compliant agents, you can add IPv6 network settings in the
Operations Console after Quick Setup is complete.

23. Verify that the settings are correct. To accept the settings, type y, or wait 30 seconds.

24. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the Quick
Setup Access Code. Record the following required information:

l The Quick Setup URL includes the IP address that you entered in step 22.
https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

25. Enter the Quick Setup URL in the browser, including https, and press ENTER:

https://<IP Address>/

Note: To confirm the authenticity of the virtual appliance, you must verify that the SHA-1 fingerprint of
the certificate presented during Quick Setup matches the SHA-1 fingerprint displayed in the OS Console.
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Deploy the Virtual Appliance Through the Hyper-V Manager

You can deploy a virtual appliance through the Hyper-V Manager. RSA provides a PowerShell script that creates
a virtual appliance. You complete configuration through the Hyper-V Manager. This process requires several
minutes to complete.

Before you begin

l Collect the required information about each appliance instance to deploy. See Secure Appliance
Deployment on page 20.

l Verify that you have the RSA Authentication Manager virtual appliance file, rsa-am-hyper-v-virtual-
appliance-8.2.1.0.0.zip.

The file contents include a Windows batch file, a PowerShell script, and two virtual hard drive (VHD)
files. The disk1 VHD file is the primary virtual hard drive that the virtual appliance uses for storage. The
disk2 VHD file is a swap drive that improves virtual appliance startup times.

After you create the virtual appliance, running the new appliance modifies the VHD files. For each virtual
appliance that you deploy with the following procedure, you must extract a new set of VHD files from the
.zip file.

Procedure

1. Log on to the Microsoft Windows 2012 or 2012 R2 Hyper-V host machine.

2. Copy the RSA Authentication Manager Hyper-V virtual appliance file, rsa-am-hyper-v-virtual-
appliance-8.2.1.0.0.zip, to a location on the Microsoft Windows 2012 or 2012 R2 Hyper-V host
machine.

3. Unzip the file to the location where you want to create the virtual appliance, but keep the original .zip
file.
For each virtual appliance that you deploy, you must extract a new set of VHD files from the .zip file.

Note: Do not rename the VHD files.

4. On the Windows taskbar, right-clickWindows PowerShell, and select Run as Administrator.

5. Change directories to the location of the Windows batch file. The virtual appliance is created in the
directory where you run the script.

Type the following, and press ENTER:

cd 'Windows_Directory_Path'

Where
'Windows_Directory_Path' is the location of the Windows batch file.

6. To create a Hyper-V virtual machine, type the following, and press ENTER:

.\create_vm.bat -name virtual_machine

Where
-name virtual_machine is the name of the virtual machine. Specify a name if you might run the batch file
more than one time. If you do not specify this option, the virtual appliance uses the default name RSA
Authentication Manager Appliance.

For example, type .\create_vm.bat -name AuthenticationMgrPrimary to create a virtual appliance
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with the name AuthenticationMgrPrimary or type .\create_vm.bat to create a virtual appliance with the
default name RSA Authentication Manager Appliance.

7. If you are prompted by a security warning, type r to run the script. By default, PowerShell has a
restrictive security policy that does not trust scripts that you download from the Internet.

8. When prompted, type y to confirm that you want to create a new virtual machine.

After the script successfully completes, connect the virtual appliance to your network.

9. In the Windows Start menu, click Server Manager > Tools > Hyper-V Manager.

10. In the Hyper-V Manager, select the node and host from the left pane.

11. In the Virtual Machines pane, select the new virtual machine.

12. In the Action pane, under the virtual machine name, click Settings.

13. In the navigation pane, click Add Hardware and configure the Network Adapter, or click Network
Adapter and select a virtual switch. Do not use the legacy network adapter. The legacy network adapter
is not supported.

14. In the Actions pane, under the virtual machine name, click Start.

15. In the Actions pane, under the virtual machine name, click Connect.

16. Wait for 30 seconds to select the default keyboard layout, English (United States). To select a different
keyboard layout, press any key and follow the instructions on the screen.

17. Read the End User License Agreement (EULA), and type yes to accept it.

18. When the OS Console prompts you, enter the following IPv4 network settings for the virtual appliance:
l Fully Qualified Hostname

l IP Address

l Subnet Mask

l Default Gateway

l (Optional) DNS Server Configuration

Note: If your deployment uses IPv6-compliant agents, you can add IPv6 network settings in the
Operations Console after Quick Setup is complete.

19. Verify that the settings are correct. To accept the settings, type y, or wait 30 seconds.

20. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the Quick
Setup Access Code. Record the following required information:

l The Quick Setup URL includes the IP address that you entered in step 18.
https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

21. Enter the Quick Setup URL in the browser, including https, and press ENTER:
https://<IP Address>/

Note: To confirm the authenticity of the virtual appliance, you must verify that the SHA-1 fingerprint of
the certificate presented during Quick Setup matches the SHA-1 fingerprint displayed in the OS Console.
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Deploy the Hardware Appliance

Use the following procedure to deploy the hardware appliance.

Before you begin

Collect the information and items that are required for a hardware deployment. For more information, see
Secure Appliance Deployment on page 20.

Procedure

1. Connect a keyboard and monitor to the hardware appliance.

2. Connect the power cord to the appliance and power on the appliance.

3. When the appliance boot screen displays, select Start RSA Authentication Manager and press
ENTER, or wait 10 seconds for Authentication Manager to load automatically.

Note: Do not use the F2 or F4 function key options that display for language and keyboard settings in
the boot screen. After you start Authentication Manager, you can change the keyboard language when
you are prompted for these settings.

4. By default, the keyboard is configured for English (United States).To retain this setting, wait 30
seconds. To configure a new language, do the following:

a. Press any key.

b. Type the number that is associated with the language you want to configure, and press ENTER.

5. Review and accept the license agreement. Do the following:
a. Press ENTER to view each proceeding line of the license agreement or press the spacebar key to

view the next screen of text.
You must press ENTER or the spacebar until you reach the end of the license agreement.

b. When prompted, type yes to accept the license agreement, and press ENTER.

6. When prompted, configure the following network settings for the appliance:
l Fully Qualified Hostname

l IP Address

l Subnet Mask

l Default Gateway

l (Optional) Primary DNS Server

l (Optional) Secondary DNS Server

7. When prompted to confirm the network settings, verify the settings are correct. To accept the settings,
type y.

8. The Quick Setup URL and the Quick Setup Access Code display. Record the following required
information:

l The Quick Setup URL includes the IP address that you entered in step 6.
https://<IP Address>/
Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

9. If you have not done so already, connect the appliance to the network.
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After you finish

RSA strongly recommends doing one of the following:

l Use standard system disk imaging software to create a backup image of the hardware appliance in case
you need to restore the original settings. RSA has qualified PING software. For more information, see
“Using PING to Back Up and Restore the RSA Authentication Manager 8.2.x Hardware Appliance” on RSA
Link: https://community.rsa.com/docs/DOC-41697.

l Prepare to remotely restore the hardware appliance in a disaster recovery situation. Do the following:

a. Enable remote access to the hardware appliance:

On a new Dell-based hardware appliance (RSA SecurID Appliance 130 or RSA SecurID Appliance
250) or an upgraded Dell-based version of the RSA SecurID Appliance 250, deploy an integrated
Dell Remote Access Controller (iDRAC).

On a new or upgraded Intel-based version of the RSA SecurID Appliance 250, deploy an Intel
Remote Management Module (RMM).

RSA has not qualified upgraded versions of the RSA SecurID Appliance 130 for remote access.

For instructions, see “Configuring Remote Access to the RSA Authentication Manager Hardware
Appliance” on RSA Link at https://community.rsa.com/docs/DOC-67160.

b. Download rsa-am-hardware-appliance-8.2.1.0.0.iso from RSA Download Central at
https://download.rsasecurity.com, and save the ISO file to a location that is accessible to the
iDRAC or RMM.

l In a disaster recovery situation, see the Help topic “Hardware Appliance System Image Installation.”

Run Quick Setup on the Primary Instance

Quick Setup configures the appliance as an RSA Authentication Manager instance. Keep the appliance on a
trusted network until Quick Setup is complete. The client computer and browser used to run Quick Setup should
also be on a trusted network.

If you do not complete Quick Setup, you will be prompted to verify the network settings every time you power on
the virtual or hardware appliance.

Before you begin

l You must have deployed a virtual appliance or hardware appliance.

l Verify that the browser on the local computer can access the license file (.zip) used during Quick Setup.
For more information, see Secure Appliance Deployment on page 20.

Note: Before performing Quick Setup, verify the date and time of the appliance BIOS. If you perform
Quick Setup with an incorrect date or time, this setting can result in a failure to start Authentication
Manager or other issues. For more information, see the Knowledgebase article 000016944 at
https://rsaportal.force.com/customer/kA070000000PL8w.

Procedure

1. Launch Quick Setup. Open a web browser and go to the following URL:
https://<IP ADDRESS>
where <IP ADDRESS> is the IP address of the appliance.
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2. If your web browser is configured for an enhanced security level, a warning states that this URL is not
on the list of allowed or trusted sites. To continue, click the option that allows your browser to connect to
an untrusted site. For example, your browser might ask you to click a link that reads “I Understand the
Risks.”

3. When prompted, enter the Quick Setup Access Code, and clickNext.

4. On the Primary and Replica Quick Setup window, click Start Primary Quick Setup.

5. On the Primary Quick Setup page, click Start Step 1.

6. Specify the location of the license file (.zip), and click Upload.
If you select an evaluation license, 25 evaluation software tokens are created. The evaluation software
tokens are provided for use with the evaluation license.

7. Review the license summary, and clickNext.

8. On the Date & Time page, do the following:
a. In the Time Zone section, do the following in this order:

l Select a region, for example, America.

l Select a location. If the time zone uses Daylight Savings Time, two offsets from
Coordinated Universal Time (UTC) are shown, for example, (UTC-05/UTC-04) New York.

b.  In the Time Source section, choose how you want the time to be set on the appliance, manually
(hardware appliance only) or automatically (hardware or virtual appliance.
To automatically synchronize the time on a hardware appliance or virtual appliance to an NTP
server:

a. Select Sync to NTP Server.

b. Enter the hostname or IP address for a local or Internet Network Time Protocol (NTP)
server.
You may enter a second NTP server. If Quick Setup cannot connect to an NTP server, you
can add an NTP Server in the Operations Console after Quick Setup is complete.

c. To test the connection to the NTP server and verify that the correct time is selected, click
Preview Current Date & Time.

To automatically synchronize the time on a virtual appliance to the VMware or Hyper-V host
machine:

a. Select Sync to the physical machine hosting this virtual appliance.

b. To test the connection to the virtual host and verify that the correct time is selected, click
Preview Current Date & Time.

To manually set the time on a hardware appliance:

a. Select Set System Time.

b. From the date box, select the date.

c. From the time drop-down boxes, select the hour and minute.

c. ClickNext.

9. On the OS Password page, create and confirm the operating system password, and clickNext.

Note: The operating system password is required to log on to the primary instance.
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Record the operating system password, so that you can access it when you need it. For security reasons,
RSA does not provide a utility for recovering the operating system password.

10. On the Initial Administration Accounts page, create the initial administration credentials for the Security
Console Super Admin and the Operations Console (OC) administrator. ClickNext.

Note: The User ID must be unique. It can contain 1 to 255 ASCII characters. The characters @ ~ are
not allowed, and spaces are not allowed. If a User ID contains unsupported characters, the user cannot
authenticate.

Record these User IDs and passwords.

Note: After you complete Quick Setup, you can create additional Super Admin and Operations Console
administrator accounts in the Security Console.

11. Review the information that you have entered. If you want to change anything, click Back, and make the
change on the appropriate page. If necessary, use the navigation links at the top of the page.

12. Click Start Configuration.

After the instance is configured, direct links are provided to the Security Console and the Operations
Console.

After you finish

l Web browsers used to administer Authentication Manager must have JavaScript enabled. See your web
browser documentation for instructions on enabling JavaScript.

l After Quick Setup completes, you can change the appliance network settings in the Operations Console.
Network Setting changes made in the VMware vSphere Client will no longer take effect.

l (Optional) You can download a text file that contains the network settings for the primary instance. You
can refer to this information if you need to restore the original system image on the hardware appliance.
For instructions, see the Help topic “Download Network Settings for a Primary or Replica Instance.”

Certificate Management for Secure Sockets Layer

Secure Sockets Layer (SSL) is enabled by default for communication ports that are used for RSA Authentication
Manager administration and replication. When you deploy an instance of Authentication Manager,
communication is secured by a long-lived SSL certificate. This certificate is unique to your deployment, and it is
signed by an internal RSA certificate authority (CA).

Because this SSL certificate is signed by an internal RSA CA, your browser may present a warning message that
the default certificate cannot be verified. If an Online Certificate Status Protocol (OCSP) client is deployed, you
may receive a message that revocation list information is not available. This is expected behavior.

To continue, click the option that allows your browser to proceed or to connect to an untrusted site. For
example, your browser might ask you to click a link that reads “I Understand the Risks.”

To prevent this warning message from appearing, you must add the internal RSA CA to your browser’s trusted
root certificate list, or replace the RSA certificate with one that is signed by a certificate authority that is trusted
by your browser.

Note: If you use dynamic seed provisioning (CT-KIP) to distribute software tokens to RSA SecurID Software
Token 2.2 or later for iOS, RSA recommends that you use a certificate that is signed by a trusted certificate
authority.
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See your browser documentation for instructions about adding the internal RSA CA to your browser’s list of
trusted root certification authorities.

Log On to the Consoles

This procedure describes how to access the Security Console, Operations Console, and the Self-Service Console.

Procedure

1. Open a supported web browser, and enter one of the URLs listed in the following table. Each console
supports more than one URL.

Console URLs

Security Console

https://<fully qualified domain name>

https://<fully qualified domain name>/sc

https://<fully qualified domain name>:7004/console-ims

Operations Console
https://<fully qualified domain name>/oc

https://<fully qualified domain name>:7072/operations-console

Self-Service Console

If there is no web tier, enter:

https://<fully qualified domain name>/ssc

https://<fully qualified domain name>:7004/console-selfservice

After installing a web tier in a deployment with both primary and replica
instances, enter:

https://<fully qualified virtual host name>

https://<fully qualified virtual host name>/ssc

https://<fully qualified virtual host name>/console-selfservice

After installing a web tier in a deployment with a primary instance only,
enter:

https://<fully qualified virtual host name>/ssc

https://<fully qualified virtual host name>/console-selfservice

If you change the default load balancer port, enter:

https://<fully qualified virtual host name>:<virtual host port>/

https://<fully qualified virtual host name>:<virtual host port>/ssc

https://<fully qualified virtual host name>:<virtual host
port>/console-selfservice

For example, if the fully qualified domain name of your appliance installation is “host.mycompany.com,”
to access the Security Console, enter one of the following URLs in your web browser:
https://host.mycompany.com
https://host.mycompany.com/sc
https://host.mycompany.com:7004/console-ims
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2. If your web browser is configured for an enhanced security level, you must add an entry to the list of
allowed or trusted sites. See your browser documentation for instructions about adding allowed or
trusted sites.

3. To access the Security Console, enter the Super Admin User ID and password that you specified during
Quick Setup. To access the Operations Console, enter the Operations Console User ID and password that
were entered during Quick Setup.

For more information on the Console accounts and passwords, see Administrative Accounts on
page 115.

Note: The Security Console may take up to 10 minutes to complete initial startup.
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Perform Deployment Tasks

Perform these steps to deploy an appliance and deploy an RSA Authentication Manager replica instance.

Procedure

1. Deploy the appliance. Do one of the following:

l For a VMware virtual appliance, you can either Deploy the Virtual Appliance Through VMware
vCenter Server on page 28 or Deploy the Virtual Appliance Directly to the VMware ESXi Server on
page 30.

l For a Hyper-V virtual appliance, you can either Deploy the Virtual Appliance Through the Hyper-V
Virtual Machine Manager Console on page 31 or Deploy the Virtual Appliance Through the Hyper-
V Manager on page 34.

l For a hardware appliance, see Deploy the Hardware Appliance on page 36.

2. Generate and Download a Replica Package File below.

3. Configure the appliance with Quick Setup, a software wizard that creates access permission and
specifies whether the appliance is a primary instance or a replica instance. See Run Quick Setup on the
Replica Instance below.

4. Attach the Replica Instance to the Primary Instance on page 47.

Generate and Download a Replica Package File

Before you can add a replica instance to the deployment, you must create a replica package file on the primary
instance. This file has configuration data that enables the replica instance to connect to the primary instance.
The replica instance must have access to this file.

Before you begin

You must be an Operations Console administrator.

Procedure

1. On the primary instance, log on to the Operations Console.

2. Click Deployment Configuration > Instances > Generate Replica Package.

3. Click Download to download the replica package file, and click Save to save the replica package to your
local machine. The name of the replica package file is replica_package.zip.

4. Click Done to return to the Operations Console Home page.

Run Quick Setup on the Replica Instance

Quick Setup performs the following tasks to add a replica appliance to the deployment:
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l Quick Setup configures the appliance as an RSA Authentication Manager replica instance.

l Quick Setup attaches the replica instance to the primary instance.

After Quick Setup configures the replica instance, you can choose one of the following options:

l Attach the replica instance immediately to the primary instance.

l Defer attaching the replica instance until a later time.

If you choose to defer attaching the replica instance, Quick Setup powers off the replica instance. The next time
you power on the replica instance, you can access Quick Startup to complete the attach process.

As a best practice, RSA recommends that you keep the appliance on a trusted network until Quick Setup is
complete. The client computer and browser used to run Quick Setup should also be on a trusted network.

If you do not complete Quick Setup, you will be prompted to verify the network settings every time you power on
the virtual or hardware appliance.

Before you begin

l Collect the required information about each replica instance that you want to set up. See Deployment
Checklist for the Primary Replica Instance on page 21.

l You must have deployed the appliance:

l For a VMware virtual appliance, see Deploy the Virtual Appliance Through VMware vCenter Server
on page 28 or Deploy the Virtual Appliance Directly to the VMware ESXi Server on page 30.

l For a Hyper-V virtual appliance, you can Deploy the Virtual Appliance Through the Hyper-V
Virtual Machine Manager Console on page 31 or Deploy the Virtual Appliance Through the Hyper-
V Manager on page 34.

l For a hardware appliance, see Deploy the Hardware Appliance on page 36.

l Generate and Download a Replica Package File on the previous page.

Note: Before performing Quick Setup, verify the date and time of the appliance BIOS. If you perform
Quick Setup with an incorrect date or time, this setting can result in a failure to start Authentication
Manager or other issues. For more information, see the Knowledgebase article 000016944 at
https://rsaportal.force.com/customer/kA070000000PL8w.

Procedure

1. Launch Quick Setup. Open a browser and go to the following URL:

https://<IP ADDRESS>

where <IP ADDRESS> is the IP address of the replica appliance.

2. If your web browser is configured for an enhanced security level, a warning states that this URL is not
on the list of allowed or trusted sites. To continue, click the option that your browser presents that
allows you to connect to an untrusted site. For example, your browser might ask you to click a link that
reads “I Understand the Risks.”

3. When prompted, enter the Quick Setup Access Code, and clickNext.
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4. On the Primary and Replica Quick Setup window, click Start Replica Quick Setup.

5. On the Replica Quick Setup page, click Start Step 1.

6. On the Date & Time Settings page, do the following in this order:

a. In the Time Zone section, do the following in this order:

l Select a region, for example, America.

l Select a location. If the time zone uses Daylight Savings Time, two offsets from
Coordinated Universal Time (UTC) are shown, for example, (UTC-05/UTC-04) New York.

b. In the Time Source section, choose how you want the time to be set on the appliance, manually
(hardware appliance only) or automatically (hardware or virtual appliance.

To automatically synchronize the time on a hardware appliance or virtual appliance to an NTP
server:

a. Select Sync to NTP Server.

b. Enter the hostname or IP address for a local or Internet Network Time Protocol (NTP)
server.

You may enter a second NTP server. If Quick Setup cannot connect to an NTP server, you
can add an NTP Server in the Operations Console after Quick Setup is complete.

c. To test the connection to the NTP server and verify that the correct time is selected, click
Preview Current Date & Time.

To automatically synchronize the time on a virtual appliance to the VMware or Hyper-V host
machine:

a. Select Sync to the physical machine hosting this virtual appliance.

b. To test the connection to the virtual host and verify that the correct time is selected, click
Preview Current Date & Time.

To manually set the time on a hardware appliance:

a. Select Set System Time.

b. From the date box, select the date.

c. From the time drop-down boxes, select the hour and minute.

c. ClickNext.

7. Create and confirm the operating system password, and clickNext.

Note: The operating system password is required to log on to the replica instance.

Record the operating system password for future use. For security reasons, RSA does not provide a
utility for recovering the operating system password.

8. Review the information that you have entered. If you want to change anything, click Back, and make the
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change on the appropriate page. If necessary, use the navigation links at the top of the page.

9. Click Start Configuration.

After the instance is configured, do one of the following:

l Click Begin Attach to attach the replica instance to the primary instance. For instructions, see
Attach the Replica Instance to the Primary Instance below.

l Click Defer Attach to attach the replica instance at another time. When prompted, confirm your
choice. The replica instance powers off. You can attach the replica instance the next time you
power on the replica instance.

After you finish

l Replica Attachment Issues and Solutions on the next page.

l (Optional) You can download a text file that contains the network settings for the replica instance. You
can refer to this information if you need to restore the original system image on the hardware appliance.
For instructions, see the Help topic “Download Network Settings for a Primary or Replica Instance.”

Attach the Replica Instance to the Primary Instance

Attaching the replica instance to the primary instance enables the replica instance to synchronize data with the
primary instance. The replica instance records all authentications locally and sends the authentication and log
data to the primary instance at regular intervals. When the primary instance is unavailable, the replica instance
holds this data locally until the primary instance becomes available.

Note: The replica instance cannot authenticate users during the attachment process.

The instances use the TCP/IP protocol over an encrypted link for secure database synchronization. Instances
can communicate over a local area network (LAN) or a wide area network (WAN).

For information on firewalls, see Port Traffic on page 108.

Before you begin

Confirm the following:

l You generated a replica package file on the primary instance and downloaded the replica package to
your local machine. For instructions, see the Help topic "Generate a Replica Package."

l The primary and replica instances can resolve and connect to each other on the following ports:

l 7002/TCP

l 7022/TCP

l 1812/TCP

l 1813/TCP

Note: Ports 1812 and 1813 are used by RSA RADIUS. If you do not plan to use RSA RADIUS, you must
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still open these ports on your network, for example, on any firewalls sitting between the primary
instance and the replica instance, for attachment to succeed.

l The RSA RADIUS service is running on the primary instance.

Even if you do not plan to use RADIUS, the service must be running for the replica attachment to
succeed.

l The clocks on the primary and replica instances are synchronized. If the clocks are off by more than 10
minutes, the attachment fails.

l If you deferred attaching the replica instance after it was configured using Quick Setup, power on the
replica instance and access Quick Setup. Quick Setup resumes at the Attach to Primary Instance page.

Procedure

1. On the Attach to Primary Instance page under Upload Replica Package, click Browse, and select the
replica package file to upload from your local machine. ClickNext.

2. Under Provide Credentials, enter your Operations Console administrator User ID and password, and
clickNext.

After you finish

l Check the replication status by viewing the Replication Status Report for the replica instance. In the
Operations Console for the replica instance, click Deployment Configuration > Instances > Status
Report.

l If you are using RSA RADIUS, verify the replication status of the RADIUS server. In the Security Console
for the replica instance, click RADIUS > RADIUS Servers.

l Make sure that the web browsers used to access the Security Console or the Operations Console have
JavaScript enabled. See your web browser documentation for instructions on enabling JavaScript.

l After the replica instance is attached to the primary instance, network setting changes made in the
VMware vSphere Client will no longer take effect. Use the Operations Console in the primary instance to
change the network settings.

Replica Attachment Issues and Solutions
If replica attachment requires additional information, perform the tasks listed in the following table.

Issue Solution

The replica instance cannot resolve the
primary instance hostname.

In the Associated Primary IP Address field, enter the primary
instance IP address, and clickNext.

The replica instance cannot reach the
primary instance.

In the Retry Options field, correct the primary instance IP
address. Choose one of the following options:

l Address network connectivity issues, and then try to
reach the primary instance again.

l Select theOverride IP Address field, and enter the
correct IP address for the primary instance. This
information is saved in the hosts file of this appliance,

48 Chapter 3: Deploying a Replica Appliance



RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

Issue Solution

and it overrides the DNS configuration, if a DNS server is
available.

ClickNext, and enter your Operations Console administrator
credentials.

The primary instance cannot resolve the
replica instance hostname

1. Update the DNS server, if applicable, or use the primary
instance Operations Console to edit the hosts file with the
correct information for the replica instance.

For instructions, see the Help topic “Edit the Appliance
Hosts File.”

2. ClickNext.

The replica instance cannot communicate
with the primary instance on the RADIUS
ports.

Verify that the RSA RADIUS service is running on the primary
instance. To do so:

1. Log on to the Operations Console on the primary instance.

2. Select Deployment Configuration > RADIUS
Servers.

3. If prompted, enter your Super Admin user ID and
password.

4. Click the server that you want to restart.

5. From the context menu, select Restart Server.

6. Select Yes, restart RADIUS server, and click Restart
Server.

After less than one minute, the RSA RADIUS Service
starts.

7. Verify that the network configuration permits remote
connections over ports 1812/TCP and 1813/TCP.

8. ClickNext.

The primary instance cannot communicate
with the replica instance on the
communication port 7002/TCP, and the
RADIUS ports 1812/TCP and 1813/TCP.

1. Verify that the network configuration permits remote
connections over the communication port 7002/TCP, and
the RADIUS ports 1812/TCP and 1813/TCP.

2. ClickNext.

If the time difference between the primary
instance and replica instance is greater than
10 minutes, replica attachment fails.

You can change the time.

On the primary instance, log on to the primary instance
Operations Console and select Administration > Date & Time.

On the replica instance, redeploy the replica instance with the
correct time. To do so:

1. Delete the failed replica instance from the Operations
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Issue Solution

Console on the primary instance. For instructions, see the
Help topic “Delete a Replica Instance.”

2. Do the following:

l For a hardware appliance, restore the original
backup image that you created when you first
deployed the appliance.

If a backup image is not available, you can apply
the original hardware appliance system image.
For instructions, see the RSA Authentication
Manager Administrator's Guide.

l For a VMware virtual appliance, in VMware
vCenter or on the ESXi server, shut down and
delete the virtual appliance for the failed replica
instance.

l For a Hyper-V virtual appliance, in the Hyper-V
System Center Virtual Machine Manager Console
or the Hyper-V Manager, shut down and delete
the virtual appliance for the failed replica
instance.

3. Deploy a new replica instance.
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Virtual Host and Load Balancer Overview

The virtual host is the gateway to the DMZ for users outside of the network who use risk-based authentication
(RBA), the Self-Service Console, and dynamic seed provisioning. You must configure a virtual host and assign
each web tier to the virtual host.

Load balancing distributes web tier traffic to the web tier servers. The web-tier deployment can include a load
balancer or you can use round robin DNS. The virtual host can be associated with up to 2 load balancers.

For more information on network configurations that require a load balancer, see the RSA Authentication
Manager Planning Guide.

Load Balancer Requirements

A load balancer must meet the following requirements:

l User persistence. The load balancer must send a client to the same server repeatedly during a session.
The load balancer must send the client to the same Authentication Manager instance or web-tier server,
depending on your deployment scenario, during an authentication session.

l X-Forwarded-For headers. Load balancers in the application layer cause all requests to appear to
come from the load balancer. You must configure load balancers to send the original client IP address in
the “X-Forwarded-For” header. This is the default for most application layer load balancers.

In addition to the required features, consider the following:

HTTPS Redirection. The load balancer must be able to redirect HTTPS requests to another URL. This allows
users to use the load balancer hostname to access the Self-Service Console.

Configure a Load Balancer and Virtual Host

When adding a load balancer, you must configure a virtual hostname, IP address, and listening port. The load
balancer acts as the virtual host providing an entry point to the demilitarized zone (DMZ). You must configure
the virtual host before you can install a web tier.

If your deployment has a load balancer, the virtual hostnamemust resolve to the public IP address of the load
balancer.

If your deployment does not have a load balancer, the virtual hostnamemust resolve to the public IP address of
your web tier.

If you change the name of the load balancer or use another load balancer, you must change the virtual hostname
accordingly.

Before you begin

l You must be a Super Admin.

l The virtual hostnamemust be configured in the Domain Name System (DNS) to point to the load
balancer.
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Procedure

1. In the Operations Console on the primary instance, click Deployment Configuration > Virtual Host
& Load Balancing.

2. If prompted, enter your Super Admin User ID and password.

3. On the Virtual Host & Load Balancing page, do the following:

a. Select Configure a virtual host and load balancers.

b. Enter a fully qualified virtual hostname unique to the deployment.

c. (Optional) Change the default port number.

d. Enter up to two load balancer IP addresses. If you are not using a load balancer, leave the IP
address blank.

e. Click Add.

4. Click Save.

The system saves the virtual hostname and key material in the keystore file.

5. On the confirmation page, read Mandatory Next Steps.

6. Click Done.

After you finish

In the Operations Console, perform the appropriate mandatory next steps.

l If you updated load balancer details, you must reboot the primary and replica instances. In the
Operations Console, clickMaintenance > Reboot Appliance and reboot each instance.

l If you updated the virtual hostname, generate a new integration script for each web-based application
using RBA, and then redeploy the integration scripts.

l If the deployment includes a web tier, update the web tier. In the Operations Console, click Deployment
Configuration > Web-Tier Deployments > Manage Existing. Click the update link for each web
tier.

l If the deployment includes a web tier, replace the certificate on the load balancer and on the firewall with
the virtual host certificate.

l If the deployment uses dynamic seed provisioning, update the hostname and port for the CT-KIP URL
with the hostname and port that you specified for the virtual host. In the Security Console, go to Setup
> System Settings. Click Tokens.

l If the deployment uses the RSA Self-Service Console, update the Self-Service Console URL with the
hostname and port you specified for the virtual host. In the Security Console, go to Setup> Self-
Service Settings. Click E-Mail Notifications for User Account Changes.
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Load Balance Using the Web Tier with Round Robin DNS

If you do not want to use a load balancer, you can set up the web-tier servers to distribute risk-based
authentication (RBA) requests using round robin Domain Name System (DNS).

To set up load balancing using round robin DNS, associate the virtual hostname with the publicly accessible IP
addresses of the web-tier servers in your DNS, and then enable round robin. The DNS server then sends RBA
requests to web-tier servers.

The following figure shows a sample deployment of Authentication Manager using round robin DNS load
balancing.
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Web Tier Overview

A web tier is a secure platform for installing and deploying the Self-Service Console, dynamic seed provisioning,
and the risk-based authentication (RBA) service.

The web tier protects the private network by receiving and managing inbound internet traffic before it enters
the private network. This prevents end users from accessing the private network through the Self-Service
Console or web-based applications, such as SSL-VPNs, thin clients, or web portals. The web-tier server only
sends a subset of the traffic, such as authentication traffic, securely to your private network.

In addition to providing network security, deploying Authentication Manager on a web-tier server in your
network demilitarized zone (DMZ) offers the following benefits:

l You can customize the end-user interface for the RBA service and web-based applications.

l Improves system performance by removing some processing tasks from the back end server.

Web-tier installation requires a primary instance. It is preferable that there is at least one replica instance of
Authentication Manager located in your private network, as well as a load balancer and two web-tier servers
located in your DMZ. An instance can have up to 16 web tiers. You need Super Admin permissions to manage
the Authentication Manager and the web-tier servers.

Web tiers are not required, but your deployment might need them to satisfy your network configuration and
requirements. For more information on the Authentication Manager deployment types, see the Planning Guide.

The following diagram shows traffic flow and ports in a typical web-tier deployment.

Self-Service, Dynamic Seed Provisioning, and RBA Traffic in a Web Tier
In Authentication Manager, self-service and dynamic seed provisioning traffic is routed to the primary instance
because these services can only run on the primary instance. RBA can run on any instance, but Authentication
Manager always routes RBA traffic to the preferred RBA instance to distribute the workload.

The preferred RBA instance is the first instance to which Authentication Manager directs RBA traffic. You must
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choose a preferred RBA instance when you deploy a web tier. RSA recommends that you select a different
preferred RBA instance for each web tier. You can select any Authentication Manager instance as a preferred
RBA instance.

The following diagram shows how Self-Service, dynamic seed provisioning, and RBA traffic flows through a web
tier.

If ever the preferred RBA instance is unavailable, Authentication Manager directs RBA traffic to the next instance
on the server list.

Note that if you delete a replica that is a preferred RBA instance, the associated web tier is also deleted. RBA
traffic flow through the deleted web tier is stopped. If the deployment has a load balancer and virtual host, make
sure that they no longer point to the deleted replica and associated web tier.

Web-Tier Hardware and Operating System Requirements

The following table lists the minimum requirements for the web-tier server. RSA recommends that you adjust
these requirements upwards based on expected usage.

Description Requirements

Hardware

Hard Drive: 2 GB for web tier installation

Hard Drive: 4 GB-20 GB free space for logs and updated component downloads

RAM: 2 GB

CPU: A CPU with a dual-core processor or better, or 2 or more CPUs.

Ports External Firewall: 443 HTTPS (TCP)
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Description Requirements

DMZ: 443 HTTPS (TCP)

Internal Firewall: 7022 T3S (TCP)

Operating Systems

Red Hat Enterprise Linux 5 Server (64-bit)

Red Hat Enterprise Linux 6 Server (64-bit)

Windows Server 2008 R2 (64-bit)

Windows Server 2012 (64-bit)

Windows Server 2012 R2 (64-bit)

Performing Web Tier Pre-Installation Tasks

Before installing a web tier, perform the following tasks to set up the web-tier environment.

Procedure

1. Verify that you have Super Admin permissions, and permissions to install software.

2. Verify that you have access to the Operations Console.

3. On Linux systems, verify that the open files hard limit for the local user is at least 4096.

4. Make sure that your web-tier servers meet the recommended hardware and operating system
requirements. For more information, see Web-Tier Hardware and Operating System Requirements on
the previous page.

5. Set up the web-tier servers in the network DMZ.

6. Confirm that the date and time on the web-tier server match the date and time on the instance with
which the web tier will be associated (primary or replica) within one minute. The time zones do not have
to be the same. For example, the web-tier server time can be 7:00 am (GMT), and the associated
instance time can be 9:00 am (GMT + 2).

7. Configure the virtual host. The virtual hostname can be a load balancer hostname or a round-robin
Domain Name System (DNS). For instructions, see Configuring a Virtual Host and Load Balancer on
page 51.

8. (Optional) On the virtual host, replace the default certificate..

9. On the load balancer and on the firewall, replace the certificate with the virtual host certificate. For
instructions, see your load balancer and firewall documentation.

10. Configure a Domain Name System (DNS) server with the Fully Qualified Hostname (FQHN) of the web
tier. The web-tier FQHN must resolve from the RSA Authentication Manager primary instance, and the
FQHN of the primary instance must resolve from the web tier.

If you cannot configure a DNS server, update the appliance hosts file with the web-tier FQHN. Click
Administration > Network > Hosts File, and follow the instructions in the Help topic “Edit the
Appliance Hosts File.”
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Installing the Web Tier

The following procedure lists the tasks for installing the web tier that is associated with the primary instance.
You must perform these tasks before you associate a replica instance with a web tier.

Before you begin

l Confirm that the virtual host and load balancer are configured.

l Decide which instance to select as the preferred RBA instance for each web tier.

Procedure

1. On the public and private DNS servers, enter the web-tier hostname and IP address.

2. On the primary instance, add a web-tier deployment record and generate a web-tier deployment
package. For instructions, see Add a Web-Tier Deployment Record below.

3. On the web-tier server, run the RSA Authentication Web-Tier Installer for your platform. For
instructions, see the following:

l Install a Web Tier on Windows Using the Graphical User Interface on page 61.

l Install a Web Tier on Windows Using the Command Line on page 63.

l Install a Web Tier on Linux Using the Graphical User Interface on page 64.

l Install a Web Tier on Linux Using the Command Line on page 65.

4. Modify the Self-Service Console URL to point to the virtual host and virtual host port. For instructions,
see the Help topic “Configure E-mail Notifications for Self-Service User Account Changes.”

5. If your deployment uses dynamic seed provisioning, modify the token-key generation URL to point to the
virtual hostname, virtual host port, and self-service console. For instructions, see the Help topic
“Configure Token Settings.”

Add a Web-Tier Deployment Record

A web-tier deployment record must exist in the database on the primary instance before you can install a web
tier. The web-tier deployment record establishes communication from the primary instance to web tier.

An instance can have up to 16 web tiers. Each web tier requires a web-tier deployment record.

In the last step of this procedure you can either generate the web-tier deployment package now or generate it at
a later date. The web-tier deployment package contains the information that RSA Authentication Manager uses
to connect a web tier to the associated instance. The web-tier deployment package is required prior to installing
the web tier. If you generate the web-tier package now, you can install the web tier now.
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Before you begin

l You must be a Super Admin.

l If you are installing a new web-tier deployment, configure a virtual hostname, listening port, and load
balancer.For instructions, see Configure a Load Balancer and Virtual Host on page 52.

Procedure

1. On the primary instance, in the Operations Console, click Deployment Configuration > Web-Tier
Deployments > Add New.

2. If prompted, enter your Super Admin User ID and password.

3. On the Add New Web-Tier Deployment page, in theDetails section, enter the following information:

l Deployment name. The name you want for the web-tier deployment (0-255 characters. The &
%> < ’ and ” characters are not allowed).

l Hostname. Fully qualified hostname of the web-tier server where you are installing the web-tier
deployment.

l Preferred RBA Instance. The instance connected to this web-tier deployment to which risk-
based authentication (RBA) traffic is directed.

4. In the Web-Tier Service Options section, turn any of the following services on or off.

l Self-Service Console

l Risk-based authentication

l Dynamic seed provisioning

5. In the Virtual Host section, confirm the following information.

l Virtual Hostname. Must be the fully qualified name of the virtual host.

l Port Number. The default is 443.

6. Do one of the following:

l Click Save. The system saves the record in the database on the associated primary instance. The
trust certificate is updated when you generate a web-tier deployment package.

l Click Save & Generate Web-Tier Package. The Generate Web-Tier Deployment Package
screen is displayed.

Note: If the web-tier hostname is not resolved, a confirmation screen displays. Follow the
instructions on the screen.

After you finish

l Confirm the details of this web-tier deployment record. For instructions, see the Help topic “View Web
Tier Deployments.”
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l If you chose to save the web-tier deployment record without generating the web-tier deployment
package, generate the web-tier deployment package before installing the web tier.

l Install the web tier. For instructions, see Installing the Web Tier on page 59.

Web-Tier Installation Checklist

RSA Authentication Manager includes web-tier installers for Windows and Linux, which are located in the RSA
Authentication Manager 8.2 Extras download kit. After a web tier is installed, the Authentication Manager
Operations Console can be used to apply version updates.

Before you launch a web-tier installer, confirm the following:

l You have obtained the RSA Authentication Manager 8.2 SP1 Extras download kit from RSA Download
Central at https://download.rsasecurity.com.

l The web tier pre-installation tasks are completed.

l The web-tier server meets the system requirements.

l The public and private DNS servers are updated with the web-tier server IP address.

l A web-tier deployment package exists and has been transferred from the primary instance to the web-
tier server.

l The Authentication Manager instance to which you will associate the web tier is running.

l You know the following information:

l Directory name and location where you want the web-tier software installed

l Fully qualified hostname of the web-tier server

l Primary NIC IP address (IPv4) of the web-tier server

l Web-tier deployment package name, location, and web-tier package password

l For Linux, local user name (do not use root)

l The hostname in the web-tier deployment package matches the hostname on the target server.

l For Linux, you have root privileges.

After you confirm the items in the checklist, launch the installer you want to use and install the web tier.

l Install a Web Tier on Windows Using the Graphical User Interface below

l Install a Web Tier on Windows Using the Command Line on page 63

l Install a Web Tier on Linux Using the Graphical User Interface on page 64

l Install a Web Tier on Linux Using the Command Line on page 65

Install a Web Tier on Windows Using the Graphical User Interface
During installation, you run the RSA Authentication Web-Tier Installer on the web-tier server. This installs
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dynamic seed provisioning, the Self-Service Console and risk-based authentication (RBA) service.

Use only numbers and English characters when specifying paths and filenames. Single-byte and double-byte
characters are not supported.

Before you begin

l Complete the Web-Tier Installation Checklist on the previous page.

l Copy theWebtier folder from the RSA Authentication Manager 8.2 Extras download kit to the supported
Windows platform. The linux-x86_64 folder is not needed.

Procedure

1. In the location where you copied the RSA Authentication Manager 8.2 SP1 Extras download kit, go to
Webtier/windows-x86_64 and locate install_webtier.bat.

2. Do one of the following:

l If User Access Control (UAC) is on, right click install_webtier.bat and select Run As
Administrator.

l If User Access Control (UAC) is off, double-click install_webtier.bat.

3. On theWelcome screen, read the overview and navigation instructions. ClickNext.

4. On the License Agreement screen, read the license agreement, and clickNext.

5. On the Installation Folder screen, specify the installation folder and clickNext.

6. On the Choose Web-Tier Package File screen, do the following:

a. Select theWeb-Tier Package for the instance to which this web-tier server is associated.

b. Type the Password.

c. ClickNext.

7. On the Summary screen, do one of the following:

l If the summary is correct, clickNext.

l If the summary is incorrect, click Previous, and correct the information.

8. On the Installation Progress screen, wait for the progress bar to indicate that the installation is
finished and clickNext.

9. On the Run Configuration screen, wait for the configuration to complete and clickNext.

10. On the Installation Summary screen, click Done.

After you finish

After you exit the web-tier installer, the Web-Tier Update Service connects to the primary server to install the
necessary services. Use the Operations Console to check the status of this process.
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In the Operations Console, click Deployment Configurations >Web-Tier Deployments > Manage
Existing to see the web tier installation status.

Install a Web Tier on Windows Using the Command Line
During installation, you run the RSA Authentication Web-Tier Installer on the web-tier server. This installs
dynamic seed provisioning, the Self-Service Console and risk-based authentication (RBA) service.

Use only numbers and English characters when specifying paths and filenames. Single-byte and double-byte
characters are not supported.

Before you begin

l Complete the Web-Tier Installation Checklist on page 61.

l Copy theWebtier folder from the RSA Authentication Manager 8.2 SP1 Extras download kit to the
supported Windows platform. The linux-x86_64 folder is not needed.

Procedure

1. In the location where you copied the RSA Authentication Manager 8.2 SP1 Extras download kit, go to
Webtier/windows-x86_64 and launch install_webtier.bat in console mode.

2. On the command line, type the following and press ENTER.

install_webtier.bat -console

3. On theWelcome screen, press ENTER.

4. On the License Agreement screen, press ENTER to continue.

5. On each successive License Agreement screen, you can do the following:

a. Press ENTER to continue to the next page of the License Agreement.

On the last screen, type YES and press ENTER to accept the terms of the license agreement.

b. Type Q to quit the License Agreement.

Type YES and press ENTER to accept the terms of the license agreement.

6. On the Installation Folder screen, enter the location of the installation folder and press ENTER.

7. On the Choose Web Tier Package screen, do the following:

a. Enter the web-tier package location and file name, and press ENTER.

b. Enter the web-tier package password, and press ENTER.

c. Press ENTER.

8. On the Summary screen, review the summary and do one of the following:

l If the summary is correct, type 1 to continue and press ENTER.

The installation begins and the Finish screen displays when the installation is successful.
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l If the summary is incorrect, type 2 and press ENTER to quit.

The installation terminates and you must begin again.

9. On the Finish screen, press ENTER to exit.

After you finish

After you exit the web tier installer, the Web-Tier Update Service connects to the primary server to install the
necessary services. Use the Operations Console to check the status of this process.

In the Operations Console, click Deployment Configurations >Web-Tier Deployments > Manage
Existing to see the web tier installation status.

Install a Web Tier on Linux Using the Graphical User Interface
During installation, you run the RSA Authentication Web-Tier Installer on the web-tier server. This installs
dynamic seed provisioning, the Self-Service Console and risk-based authentication (RBA) service.

l Use only numbers and English characters when specifying paths and filenames. Single-byte and
double-byte characters are not supported.

l The install user must have execute permission for the folder into which the web tier is installed.

l Do not save the web-tier installer and the web-tier package under the /root directory.

l Do not use spaces in the installation path.

Before you begin

l Verify that the open files hard limit for the local user is at least 4096.

l Complete the Web-Tier Installation Checklist on page 61.

l Copy theWebtier folder from the RSA Authentication Manager8.2 SP1 Extras download kit to the /tmp
directory on the supported Linux platform. You can exclude thewindows-x86_64 folder.

Procedure

1. Log on as root.

2. On the command line, change directories to the location where you copied theWebtier folder from the
RSA Authentication Manager 8.2 SP1 Extras download kit. Type the following and press ENTER:

cd /tmp/Webtier/linux-x86_64

3. Specify read, write, and execute access for the installation files. On the command line, do the following:

l For the install_webtier.sh file, type the following, and press ENTER:

chmod 777 ./install_webtier.sh

l For the /tmp/Webtier/linux-x86_64/jdk/bin directory, type the following, and press
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ENTER:

chmod 777 ./*

4. On the command line, type the following, and press ENTER:

./install_webtier.sh

5. On the RSA Authentication Manager Web-Tier Installer screen, clickNext.

6. On theWelcome screen, read the overview and navigation instructions and clickNext.

7. On the License Agreement screen, read the license agreement. Accept the terms, and ClickNext.

8. On the Installation Folder screen, specify the installation folder and clickNext.

9. On the Choose Web-Tier Package File screen, do the following:

a. Select theWeb-Tier Package for the instance to which this web-tier server is associated.

b. Type the Password.

c. ClickNext.

10. On the Install User screen, enter the local user name and click Next.

11. On the Summary screen, do one of the following:

l If the summary is correct, clickNext.

l If the summary is incorrect, click Previous, and correct the information.

12. On the Installation Progress screen, wait for the progress bar to indicate that the installation is
complete and clickNext.

13. On the Run Configuration screen, wait for the configuration to complete and clickNext.

14. On the Installation Summary screen, click Done.

15. Delete theWebtier folder from the /tmp directory.

After you finish

After you exit the web-tier installer, the Web-Tier Update Service connects to the primary server to install the
necessary services. Use the Operations Console to check the status of this process.

In the Operations Console, click Deployment Configurations >Web-Tier Deployments > Manage
Existing to view the web tier installation status.

Install a Web Tier on Linux Using the Command Line
During installation, you run the RSA Authentication Web-Tier Installer on the web-tier server. This installs
dynamic seed provisioning, the Self-Service Console and risk-based authentication (RBA) service.

l Use only numbers and English characters when specifying paths and filenames. Single-byte and
double-byte characters are not supported.
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l The install user must have execute permission for the folder into which the web tier is installed.

l Do not save the web-tier installer and the web-tier package under the /root directory.

l Do not use spaces in the installation path.

Before you begin

l Verify that the open files hard limit for the local user is at least 4096.

l Complete the Web-Tier Installation Checklist on page 61.

l Copy theWebtier folder from the RSA Authentication Manager 8.2 SP1 Extras download kit to the /tmp
directory on the supported Linux platform. You can exclude thewindows-x86_64 folder.

Procedure

1. Log on as root.

2. On the command line, change directories to the location where you copied theWebtier folder from the
RSA Authentication Manager 8.2 SP1 Extras download kit. Type the following and press ENTER:

cd /tmp/Webtier/linux-x86_64

3. Specify read, write, and execute access for the installation files. On the command line, do the following:

l For the install_webtier.sh file, type the following, and press ENTER:

chmod 777 ./install_webtier.sh

l For the /tmp/Webtier/linux-x86_64/jdk/bin directory, type the following, and press
ENTER:

chmod 777 ./*

4. On the command line, type the following and press ENTER.

./install_webtier.sh -console

5. On theWelcome screen, type 1 to continue and press ENTER.

6. On the License Agreement screen, press ENTER to continue.

7. On each successive License Agreement screen, you can do the following:

l Press ENTER to continue to the next page of the License Agreement.

On the last screen, type YES and press ENTER to accept the terms of the license agreement.

l Type Q to quit the License Agreement.

Type YES and press ENTER to accept the terms of the license agreement.

8. On the Installation Folder screen, do the following:
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a. Enter the location of the installation folder.

b. Press ENTER.

9. On the Choose Web Tier screen, do the following:

a. Enter the web-tier package location and file name, and press ENTER.

b. Enter the web-tier package password, and press ENTER.

c. Press ENTER.

10. On the Installation User screen, do the following:

a. Enter the installation user, and press ENTER.

b. Press ENTER.

11. On the Summary screen, review the summary and do one of the following:

a. If the summary is correct, type 1 to continue and press ENTER.

The installation begins and the Finish screen displays when the installation is successful.

b. If the summary is incorrect, type 2 and press ENTER to quit.

The installation terminates and you must begin again.

12. On the Finish screen, press ENTER to exit.

13. Delete theWebtier folder from the /tmp directory.

After you finish

After you exit the web tier installer, the Web-Tier Update Service connects to the primary server to install the
necessary services. Use the Operations Console to check the status of this process.

In the Operations Console, click Deployment Configurations >Web-Tier Deployments > Manage
Existing to view the web tier installation status.
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Next Steps for Your Deployment

After deploying RSA Authentication Manager, you must perform the required configuration tasks. You can
perform additional configuration tasks based upon your deployment.

Topic Description For More Information

Required Steps for All Deployments

Port Usage

Confirm that the ports on the primary and replica instances
and the primary and replica web-tier servers are accessible
to enable authentication, administration, replication, and
other services on the network.

See Port Traffic on page 108.

RSA
Authentication
Manager User
Accounts

Each user must have an account in RSA Authentication
Manager. You can create and store user accounts in the
internal database, or you can link Authentication Manager
directly to one or more external Lightweight Directory
Access Protocol (LDAP) directories.

For more information on using the
internal database, see the Help
topic "RSA Authentication Manager
Users."

For more information on using your
existing LDAP directories, see the
Help topic "RSA Authentication
ManagerIdentity Sources."

Authentication
Agents

An authentication agent is the component on the protected
resource that communicates with RSA Authentication
Manager to process authentication requests. Any resource
that is used with SecurID authentication, on-demand
authentication (ODA) or risk-based authentication (RBA)
requires an authentication agent.

For a list of RSA authentication
agents, go to
http://www.emc.com/security/rsa-
securid/rsa-securid-
authentication-
agents.htm#!offerings.

For a list of third-party products
that have embedded RSA agents, go
to the RSA Ready Partner Program
web site at www.rsaready.com.

RSA RADIUS Configuration

RSA RADIUS
Configuration

In a RADIUS-protected network, RADIUS clients control
user access at the network perimeter.

RADIUS clients, which can be VPN servers, wireless access
points, or Network Access Servers connected to dial-in
modems, interact with RSA RADIUS servers for user
authentication and to establish appropriate access control
parameters.

When authentication succeeds, RADIUS servers return a
set of attributes to RADIUS clients for session control.

See the Help topic "RSA RADIUS
Overview."

Authentication Method Configuration

Hardware and
Software
Tokens

Hardware Token

Device manufactured by RSA that generates and displays
tokencodes. A tokencode is always displayed and changes

See the Help topic "RSA SecurID
Tokens.”

70 Chapter 6: Next Steps for Your Deployment

http://www.emc.com/security/rsa-securid/rsa-securid-authentication-agents.htm#!offerings
http://www.emc.com/security/rsa-securid/rsa-securid-authentication-agents.htm#!offerings
http://www.emc.com/security/rsa-securid/rsa-securid-authentication-agents.htm#!offerings
http://www.emc.com/security/rsa-securid/rsa-securid-authentication-agents.htm#!offerings
https://www.rsa.com/en-us/partner/rsa-ready-program.html


RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

Topic Description For More Information

automatically at intervals, such as every 60 seconds. The
tokencode must be combined with the user’s PIN to create a
passcode, which enables authentication. Hardware tokens
include PINPads, key fobs, and USB tokens.

Software Token

Software-based security token installed with an associated
RSA SecurID application to a Windows desktop or laptop,
web browser, an RSA Smart Card, a personal digital
assistant (PDA), or a mobile device.

In most cases, software tokens are configured to request a
user’s PIN. The software token combines the PIN with the
tokencode, and then displays the passcode, which enables
authentication.

Risk-Based
Authentication
(RBA)

RBA identifies potentially risky or fraudulent authentication
attempts by silently analyzing user behavior and the device
of origin. RBA strengthens traditional password-based
authenticationRSA SecurID authentication.

See the Help topic
“Risk-Based Authentication.”

On-Demand
Authentication
(ODA)

ODA delivers a one-time tokencode to a user by e-mail or
text message. You must configure the on-demand
tokencode delivery method. Install the authentication agent
software on the resource that you want to protect, unless
the agent is already embedded in the protected resource.

See the Help topic
“On-Demand Authentication.”

Cloud
Authentication
Service

The Authentication Manager Enterprise and Premium
Edition license includes the Cloud Authentication Service.
The Cloud Authentication Service supports multiple forms
of authentication, such as mobile-optimized push
notification, fingerprint verification, EyePrint ID, and
standards-based FIDO tokens.

The Cloud Authentication Service helps secure access to
software as a service (SaaS) and on-premise web
applications for users. The Cloud Authentication Service
can also accept authentication requests from a third-party
single sign-on (SSO) solution or web application that has
been configured to use RSA SecurID Access as the identity
provider (IdP) for authentication.

RSA Authentication Manager can accept tokencodes
generated by the RSA SecurID Authenticate app to provide
strong authentication and convenient single sign-on to
protected resources. Users install the RSA SecurID
Authenticate app on a supported device to generate
tokencodes.

To deploy the Cloud Authentication
Service, contact your RSA Sales
representative.

Additional Deployment Steps

Self-service
configuration

You can configure RSA Authentication Manager to enable
users to performmaintenance and troubleshooting tasks

See the Help topic “RSA Self-Service
Overview.”
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Topic Description For More Information

Self-Service Console.

Custom logon
banners

You can display a custom logon banner before users log on
to the Operations Console, the Security Console, the Self-
Service Console, or the appliance operating system with a
Secure Shell (SSH) client.

The logon banner is often used for legal reasons, for
example, to warn users that only authorized personnel have
permission to access the system.

See the Help topic "Custom Logon
Banners."

Securing Your
Deployment

You may need to perform additional network and product
configuration for secure operation, depending on your
network topology and on the RSA Authentication Manager
features that you intend to use.

In addition, each RSA Authentication Manager instance
includes Clam Antivirus (ClamAV) software. ClamAV is an
open-source software toolkit that is intended to reduce the
risk of intrusion or malicious system or data access.

See the RSA Authentication
ManagerSecurity Configuration
Guide.
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Upgrading to RSA Authentication Manager 8.2 SP 1

You can apply the RSA Authentication Manager 8.2 SP1 upgrade patch to any hardware appliance or virtual
appliance that has RSA Authentication Manager 8.2 software.

Note: You must upgrade to RSA Authentication Manager 8.2 before applying version 8.2 SP1. For instructions,
see Upgrading to RSA Authentication Manager 8.2 on page 82, Applying RSA Authentication Manager 8.1 SP1 on
page 90, or Upgrading RSA Authentication Manager 8.0 to 8.1 on page 98.

RSA Authentication Manager 8.2 SP1 includes the software fixes in the cumulative Patch 3 for version 8.2.
Applying version 8.2 SP1 removes any software fixes that are not included in the cumulative Patch 3 for version
8.2. You must apply version 8.2 SP1 patches to obtain these fixes.

To apply version 8.2 SP1, perform these tasks in order:

1. Review the prerequisites. See Before Installing RSA Authentication Manager 8.2 SP1 below.

2. Follow the standard steps to apply an 8.2 SP1 update. See Installing Version 8.2 SP1 on the facing page.

3. If your deployment includes a web tier, you reinstall it. See Web Tier Overview on page 56

Before Installing RSA Authentication Manager 8.2 SP1

Before installing this upgrade, review the following guidelines and requirements.

Backup Strongly Recommended
RSA Authentication Manager 8.2 SP1 is not reversible. If the upgrade patch is not applied successfully, you
must restore from a backup file, a VMware snapshot, or a Hyper-V checkpoint. Trying to apply version 8.2 SP1
again is not recommended.

Note: RSA strongly recommends backing up your deployment, backing up a hardware appliance with PING,
taking a VMware snapshot, or creating a Hyper-V checkpoint before applying version 8.2 SP1.

l If you deployed a hardware appliance or a virtual appliance, you can back up the version 8.2 database.
Use the Back Up Now feature in the Operations Console of the primary instance. See the Help topic
“Create a Backup using Back Up Now.”

l If you deployed a hardware appliance, RSA recommends using standard system disk imaging software
to create a backup image in case you need to restore the hardware appliance. RSA has qualified PING
software. For more information, see “Using PING to Back Up and Restore the RSA Authentication Manager
8.2.x Hardware Appliance” on RSA Link: https://community.rsa.com/docs/DOC-41697.

l If you deployed a VMware virtual appliance, you can take a snapshot of each virtual machine in the
version 8.2 deployment. When you take a snapshot of an Authentication Manager instance, you must
specify the following settings:
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l Do not save the virtual machine’s memory.

l Choose to quiesce the guest file system. This option pauses running processes on the
Authentication Manager instance.

For additional instructions, see the VMware vSphere Client documentation.

l If you deployed a Hyper-V virtual appliance, you can create a checkpoint of the version 8.2 deployment.
For additional instructions, see the Microsoft Hyper-V documentation.

You can restore version 8.2 if you took a VMware snapshot or a Hyper-V checkpoint before applying version 8.2
SP1. Export your data or take other steps to preserve your data before reverting to a snapshot or checkpoint.
See the RSA Authentication Manager Administrator's Guide for information about restoring snapshots and
checkpoints.

You can restore version 8.2 if you backed up your deployment before applying version 8.2 SP1. See the Help
topic “Restore from Backup.”

Replicated Deployments
If you have a replicated deployment, all replica instances must be running and replicating successfully before
you apply version 8.2 SP1 or any other update or patch to the primary instance. To verify the replication status,
log on to the primary instance Operations Console, and then click Deployment Configuration > Instances >
Status Report.

Apply version 8.2 SP1 to the RSA Authentication Manager primary instance before upgrading the replica
instances in your RSA Authentication Manager 8.2 deployment. On the primary instance, the replication status
displays “Internal Replication Error” or another error until all replica instances have been upgraded or patched.
The RADIUS server replication status also displays a replication status of "package failure" or another error until
all replica instances have been upgraded or patched.

Note: You must successfully upgrade your primary instance before upgrading your replica instances.

Additional Requirements
Version 8.2 SP1 has the following additional requirements:

l Each virtual appliance must have at least 4 GB of free disk space to apply version 8.2 SP1.

l The following credentials are required for the upgrade:

l Operating system password for the rsaadmin user account on each virtual appliance.

l An Operations Console administrator account, with access to the Operations Console, for the
primary instance and each replica instance.

Installing Version 8.2 SP1

The RSA Authentication Manager 8.2 SP1 ZIP file, am-update-8.2.1.0.0.zip, contains the RSA Authentication
Manager 8.2 SP1 ISO file, am-update-8.2.1.0.0.iso, that is used to apply version 8.2 SP1 to Authentication
Manager.

You can apply an update through your web browser, or you can store the service pack in an NFS share, a shared
folder on Windows, a DVD/CD, or an ISO image on your local machine.
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The overall steps to install this service pack are as follows:

l Specify a Product Update Location below

l Scan for Updates on the facing page

l Apply the Product Update on page 78

Specify a Product Update Location
To specify a product update location, or to edit a previously specified location, perform the following procedure
to allow RSA Authentication Manager 8.2 to locate the RSA Authentication Manager 8.2 SP1 ISO file.

If you have already specified a location, see Scan for Updates on the facing page.

Before you begin

l Download the version 8.2 SP1 from RSA Link to a location that the primary or replica instance can
access.

l If you intend to scan for updates on an RSA-supplied DVD or CD, do the following:

l On a hardware appliance, use the DVD/CD drive or mount an ISO image.

l On a virtual appliance, you must configure the virtual appliance to mount a DVD/CD or an ISO
image. See the Help topic “VMWare DVD/CD or ISO Image Mounting Guidelines” or “Hyper-V
DVD/CD or ISO Image Mounting Guidelines.”

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. On the Update & Rollback page, your local browser is configured as the method for applying an update.
To change that setting, click Configure Update Source.

3. On the Configure Update Sources page, specify a location for updates.

l To upload the update from your local machine, select Use your web browser to upload an
update.

l To scan for updates on an NFS share, select Use NFS as the update source. Enter the full
path, including the IP address or hostname where updates are stored. For example:
192.168.1.2:/updates

l To scan for updates on a Windows shared folder, select Use Windows Share as the update
source.

l In theWindows Share Path field, enter the full path, including the IP address or
hostname where updates are stored. For example: \\192.168.1.2\updates

l (Optional) In theWindows Username field, enter a username. If your Windows share
configuration requires it, enter the domain and username.
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l (Optional) In the Windows Password field, enter a password only if it is required by your
Windows share configuration.

l To scan for updates on a DVD or CD, select Use DVD/CD as the update source.

4. To test the NFS or Windows share directory settings, click Test Connection. A message indicates
whether the configured shared directory is available to the primary or replica instance.

5. Click Save.

After you finish

Do one of the following:

l If you configured your local web browser as the method to apply an update, see Apply the Product
Update on the next page.

l If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, see
Scan for Updates below.

Scan for Updates
If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, you can scan
to locate and review a list of available product updates.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. Click Scan for Updates. You can view the progress of the scan on the Basic Status View tab. You can
view more detailed information on the Advanced Status View tab.

3. Click Done to return to the Update & Rollback page.

The Available Updates section displays a list of updates, with the following information for each
update:

l Version. The version of the update. To see the current Authentication Manager version, see the
top of the Update and Rollback page.

l Reversible. Indicates whether you can roll back (undo) the update. Service pack 1 is not
reversible.

l Automatic Appliance Reboot. Indicates whether Authentication Manager automatically
restarts the Appliance to apply the update. If the Appliance restarts, you must perform another
scan to see a current list of updates.

l Automatic Operations Console Reboot. Indicates whether Authentication Manager
automatically restarts the Operations Console to apply the update. If the Operations Console
restarts, you must perform another scan to see a current list of updates.

l Action. States whether the update is available to apply. Lists the minimum system requirement
for the update.

4. In the Applied Updates section, click Download Detailed History Log for a complete update history.
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The Applied Updates section displays the updates applied to the instance. This section includes the
update version numbers, the time and date that each update was applied, and which administrator
applied the update.

After you scan for updates, the new list displays for 24 hours. Logging out of the Operations Console
does not remove the list from the system cache. If you restart the Operations Console, download
additional updates, or change the product update locations, you must perform another scan to see the
most current list.

After you finish

Apply the version 8.2 SP1 upgrade patch to the RSA Authentication Manager deployment. See Apply the Product
Update below.

Apply the Product Update
Apply the product update to the primary instance first, and then to each replica instance. As each replica
instance is updated, all of the accumulated data on each replica instance is sent to the primary instance.

Note: You must successfully upgrade your primary instance before upgrading your replica instances.

Before you begin

l Ensure that port 8443/TCP is open for https traffic.

Access to this port is required for real-time status messages when applying RSA Authentication Manager
patches and service packs.

During a product update, the appliance opens this port in its internal firewall. The appliance closes this
port when the update is complete.

If an external firewall blocks this port, the browser displays an inaccessible or blank web page, but the
update can successfully complete.

l Specify a Product Update Location on page 76

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update location,
Scan for Updates on the previous page.

l In a replicated deployment, all replica instances must be running and replicating successfully before
you apply version 8.2 SP1 or any other update or patch to the primary instance. To verify the replication
status, log on to the primary instance Operations Console, and then click Deployment Configuration
> Instances > Status Report.

After upgrading the primary instance, the Authentication Manager replication status displays “Internal
Replication Error” or another error until all replica instances have been upgraded or patched. The
RADIUS server replication status also displays a replication status of "package failure" or another error
until all replica instances have been upgraded or patched.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. RSA recommends applying the most recent update. Do one of the following, depending on your
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configuration:

l To apply an update through your local web browser, do the following:

a. Click Upload & Apply Update.

b. Click Browse to navigate to the location of the update. You cannot type the update
location in the Update Path field.

c. Click Upload.

d. Verify the update details, and click Apply.

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update
location, do the following:

a. Click Scan for Updates. Available Updates displays all of the updates that can be
applied.

b. Next to the update to apply, click Apply Update.

c. Click Confirm to apply the update.

3. In the Password field, enter the password for the operating system user rsaadmin, and click Log On.

4. The basic status messages appear while the update is applied. You can view more detailed information
on the Advanced Status View tab.

Note: If the browser displays an inaccessible or blank web page, then port 8443/TCP might be blocked
by an external firewall. Real-time status messages are not available. Wait for the update to complete.

After the upgrade is applied, the following occurs:

l The appliance automatically restarts. When the restart is complete, click Done.

l Authentication Manager moves the update from the Available Updates section to the Applied Updates
section.

l When you return to the Update & Rollback page, the update is listed in the Applied Updates section.
To save the high-level update history, click Download Detailed History Log.

l The software version information is updated. To view the software version information, log on to the
Security Console, and click Software Version Information.

After you finish

l You can download a detailed log file containing the information that was displayed on the Advanced
Status View tab. The file is named update-version-timestamp.log, where version is the update
version number and timestamp is the time that the update completed. For instructions, see the Help
topic “Download Troubleshooting Files.”

l After you have upgraded the primary instance and all of the replica instances, do the following:
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l Verify that replication and radius replication is functioning correctly on the primary instance and
the replica instance.

l Version 8.2 SP1 includes the software fixes in the cumulative Patch 3 for version 8.2. As needed,
obtain later software fixes by applying the latest version 8.2 SP1 cumulative patches to the
upgraded Authentication Manager instances.

l If the deployment includes a web tier, you must reinstall it. For instructions, see Web Tier Overview on
page 56.
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Upgrading to RSA Authentication Manager 8.2

You can apply the RSA Authentication Manager 8.2 upgrade patch to any hardware appliance or virtual
appliance that has RSA Authentication Manager 8.1 Service Pack 1 (SP1) software.

Note: You must upgrade to RSA Authentication Manager 8.1 SP1 before applying version 8.2. For instructions,
see Applying RSA Authentication Manager 8.1 SP1 on page 90 or Upgrading RSA Authentication Manager 8.0 to
8.1 on page 98.

RSA Authentication Manager 8.2 includes the software fixes in the cumulative Patch 12 for version 8.1 SP1.
Applying version 8.2 removes any software fixes that are not included in the cumulative Patch 12 for version 8.1
SP1. You must apply version 8.2 patches to obtain these fixes.

To apply version 8.2, perform these tasks in order:

1. Review the prerequisites. See Before Installing RSA Authentication Manager 8.2 below.

2. Follow the standard steps to apply an 8.2 update. See Installing Version 8.2 on page 84.

3. If your deployment includes a web tier, you reinstall it. See Web Tier Overview on page 56

Before Installing RSA Authentication Manager 8.2

Before installing this upgrade, review the following guidelines and requirements.

Backup Strongly Recommended
RSA Authentication Manager 8.2 is not reversible. If the upgrade patch is not applied successfully, you must
restore from a backup file, a VMware snapshot, or a Hyper-V checkpoint. Trying to apply version 8.2 again is not
recommended.

Note: RSA strongly recommends backing up your deployment, backing up a hardware appliance with PING,
taking a VMware snapshot, or creating a Hyper-V checkpoint before applying version 8.2.

l If you deployed a hardware appliance or a virtual appliance, you can back up the version 8.1 database.
Use the Back Up Now feature in the Operations Console of the primary instance. See the Help topic
“Create a Backup using Back Up Now.”

l If you deployed a hardware appliance, RSA recommends using standard system disk imaging software
to create a backup image in case you need to restore the hardware appliance. RSA has qualified PING
software. For more information, see “Using PING to Back Up and Restore the RSA Authentication Manager
8.2.x Hardware Appliance” on RSA Link: https://community.rsa.com/docs/DOC-41697.

l If you deployed a VMware virtual appliance, you can take a snapshot of each virtual machine in the
version 8.1 SP1 deployment. When you take a snapshot of an Authentication Manager instance, you
must specify the following settings:
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l Do not save the virtual machine’s memory.

l Choose to quiesce the guest file system. This option pauses running processes on the
Authentication Manager instance.

For additional instructions, see the VMware vSphere Client documentation.

l If you deployed a Hyper-V virtual appliance, you can create a checkpoint of the version 8.1 SP1
deployment. For additional instructions, see the Microsoft Hyper-V documentation.

You can restore version 8.1 SP1 if you took a VMware snapshot or a Hyper-V checkpoint before applying version
8.2. Export your data or take other steps to preserve your data before reverting to a snapshot or checkpoint. See
the RSA Authentication Manager Administrator's Guide for information about restoring snapshots and
checkpoints.

You can restore version 8.1 SP1 if you backed up your deployment before applying version 8.2. See the Help
topic “Restore from Backup.”

Save Custom SSH Logon Banner Information
Version 8.2 includes a custom Secure Shell (SSH) logon banner feature. If you deployed a custom SSH logon
banner for an earlier version of Authentication Manager, you must save a copy of the sshd_config file from the
/etc/ssh/ directory. The version 8.2 upgrade modifies /etc/ssh/ sshd_config, and creates a ssh-banner-
sample file in the /opt/rsa/am/utils/etc/ directory. After the upgrade is complete, restore your copy of
sshd_config.

Replicated Deployments
If you have a replicated deployment, all replica instances must be running and replicating successfully before
you apply version 8.2 or any other update or patch to the primary instance. To verify the replication status, log
on to the primary instance Operations Console, and then click Deployment Configuration > Instances >
Status Report.

Apply version 8.2 to the primary instance before upgrading the replica instances in your RSA Authentication
Manager 8.1 SP1 deployment. On the primary instance, the replication status displays “Internal Replication
Error” or another error until all replica instances have been upgraded or patched.

Note: You must successfully upgrade your primary instance before upgrading your replica instances.

Additional Requirements
Version 8.2 has the following additional requirements:

l Each virtual appliance must have at least 4 GB of free disk space to apply version 8.2.

l MD5 certificates are no longer supported for identity sources. Authentication Manager can only connect
to identity sources that use SHA-1 or SHA-2 certificates. For instructions on how to replace any existing
MD5 certificates, see the Help topics “Delete an Identity Source SSL Certificate” and “Add an Identity
Source SSL Certificate.”

l The following credentials are required for the upgrade:

l Operating system password for the rsaadmin user account on each virtual appliance.
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l An Operations Console administrator account, with access to the Operations Console, for the
primary instance and each replica instance.

Installing Version 8.2

The RSA Authentication Manager 8.2 ZIP file, am-update-8.2.0.0.0.zip, contains the RSA Authentication
Manager 8.2 ISO file, am-update-8.2.0.0.0.iso, that is used to apply version 8.2 to Authentication Manager.

You can apply an update through your web browser, or you can store the service pack in an NFS share, a shared
folder on Windows, a DVD/CD, or an ISO image on your local machine.

The overall steps to install this service pack are as follows:

l Specify a Product Update Location below

l Scan for Updates on the facing page

l Apply the Product Update on page 86

Specify a Product Update Location
To specify a product update location, or to edit a previously specified location, perform the following procedure
to allow RSA Authentication Manager 8.1 SP1 to locate the RSA Authentication Manager 8.2 ISO file.

If you have already specified a location, see Scan for Updates on the facing page.

Before you begin

l Download the version 8.2 upgrade from RSA Link to a location that the primary or replica instance can
access.

l If you intend to scan for updates on an RSA-supplied DVD or CD, do the following:

l On a hardware appliance, use the DVD/CD drive or mount an ISO image.

l On a virtual appliance, you must configure the virtual appliance to mount a DVD/CD or an ISO
image. See the Help topic “VMWare DVD/CD or ISO Image Mounting Guidelines” or “Hyper-V
DVD/CD or ISO Image Mounting Guidelines.”

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. On the Update & Rollback page, your local browser is configured as the method for applying an update.
To change that setting, click Configure Update Source.

3. On the Configure Update Sources page, specify a location for updates.

l To upload the update from your local machine, select Use your web browser to upload an
update.

l To scan for updates on an NFS share, select Use NFS as the update source. Enter the full
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path, including the IP address or hostname where updates are stored. For example:
192.168.1.2:/updates

l To scan for updates on a Windows shared folder, select Use Windows Share as the update
source.

l In theWindows Share Path field, enter the full path, including the IP address or
hostname where updates are stored. For example: \\192.168.1.2\updates

l (Optional) In theWindows Username field, enter a username. If your Windows share
configuration requires it, enter the domain and username.

l (Optional) In the Windows Password field, enter a password only if it is required by your
Windows share configuration.

l To scan for updates on a DVD or CD, select Use DVD/CD as the update source.

4. To test the NFS or Windows share directory settings, click Test Connection. A message indicates
whether the configured shared directory is available to the primary or replica instance.

5. Click Save.

After you finish

Do one of the following:

l If you configured your local web browser as the method to apply an update, see Apply the Product
Update on the next page.

l If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, see
Scan for Updates below.

Scan for Updates
If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, you can scan
to locate and review a list of available product updates.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. Click Scan for Updates. You can view the progress of the scan on the Basic Status View tab. You can
view more detailed information on the Advanced Status View tab.

3. Click Done to return to the Update & Rollback page.

The Available Updates section displays a list of updates, with the following information for each
update:

l Version. The version of the update. To see the current Authentication Manager version, see the
top of the Update and Rollback page.

l Reversible. Indicates whether you can roll back (undo) the update. Service pack 1 is not
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reversible.

l Automatic Appliance Reboot. Indicates whether Authentication Manager automatically
restarts the Appliance to apply the update. If the Appliance restarts, you must perform another
scan to see a current list of updates.

l Automatic Operations Console Reboot. Indicates whether Authentication Manager
automatically restarts the Operations Console to apply the update. If the Operations Console
restarts, you must perform another scan to see a current list of updates.

l Action. States whether the update is available to apply. Lists the minimum system requirement
for the update.

4. In the Applied Updates section, click Download Detailed History Log for a complete update history.

The Applied Updates section displays the updates applied to the instance. This section includes the
update version numbers, the time and date that each update was applied, and which administrator
applied the update.

After you scan for updates, the new list displays for 24 hours. Logging out of the Operations Console
does not remove the list from the system cache. If you restart the Operations Console, download
additional updates, or change the product update locations, you must perform another scan to see the
most current list.

After you finish

Apply the version 8.2 upgrade patch to the RSA Authentication Manager deployment. See Apply the Product
Update below.

Apply the Product Update
Apply the product update to the primary instance first, and then to each replica instance. As each replica
instance is updated, all of the accumulated data on each replica instance is sent to the primary instance.

Note: You must successfully upgrade your primary instance before upgrading your replica instances.

Before you begin

l Ensure that port 8443/TCP is open for https traffic.

Access to this port is required for real-time status messages when applying Authentication Manager
patches and service packs.

During a product update, the appliance opens this port in its internal firewall. The appliance closes this
port when the update is complete.

If an external firewall blocks this port, the browser displays an inaccessible or blank web page, but the
update can successfully complete.

l Specify a Product Update Location on page 84

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update location,
Scan for Updates on the previous page.

l In a replicated deployment, all replica instances must be running and replicating successfully before
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you apply version 8.2 or any other update or patch to the primary instance. To verify the replication
status, log on to the primary instance Operations Console, and then click Deployment Configuration
> Instances > Status Report.

After upgrading the primary instance, the replication status displays “Internal Replication Error” or
another error until all replica instances have been upgraded or patched.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. RSA recommends applying the most recent update. Do one of the following, depending on your
configuration:

l To apply an update through your local web browser, do the following:

a. Click Upload & Apply Update.

b. Click Browse to navigate to the location of the update. You cannot type the update
location in the Update Path field.

c. Click Upload.

d. Verify the update details, and click Apply.

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update
location, do the following:

a. Click Scan for Updates. Available Updates displays all of the updates that can be
applied.

b. Next to the update to apply, click Apply Update.

c. Click Confirm to apply the update.

3. In the Password field, enter the password for the operating system user rsaadmin, and click Log On.

4. The basic status messages appear while the update is applied. You can view more detailed information
on the Advanced Status View tab.

Note: If the browser displays an inaccessible or blank web page, then port 8443/TCP might be blocked
by an external firewall. Real-time status messages are not available. Wait for the update to complete.

After the upgrade is applied, the following occurs:

l The appliance automatically restarts. When the restart is complete, click Done.

l Authentication Manager moves the update from the Available Updates section to the Applied Updates
section.

l When you return to the Update & Rollback page, the update is listed in the Applied Updates section.
To save the high-level update history, click Download Detailed History Log.

l The software version information is updated. To view the software version information, log on to the
Security Console, and click Software Version Information.
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After you finish

l You can download a detailed log file containing the information that was displayed on the Advanced
Status View tab. The file is named update-version-timestamp.log, where version is the update
version number and timestamp is the time that the update completed. For instructions, see the Help
topic “Download Troubleshooting Files.”

l After you have upgraded the primary instance and all of the replica instances, do the following:

l Verify that replication and radius replication is functioning correctly on the primary instance and
the replica instance.

l Version 8.2 includes the software fixes in the cumulative Patch 12 for version 8.1 SP1. As
needed, obtain later software fixes by applying the latest version 8.2 cumulative patches to the
upgraded Authentication Manager instances.

l If the deployment includes a web tier, see Web Tier Overview on page 56

l (Optional) RSA Authentication Manager uses internal certificates for communication between
Authentication Manager components, such as primary and replica instances and the web tier. After you
upgrade to RSA Authentication Manager 8.2, you can run a command-line utility that upgrades the
existing internal certificates from SHA-1 to SHA-256. The SHA-256 digital certificates uses the
“SHA256withRSA” digital signature algorithm.

The internal certificates are only used by RSA Authentication Manager components. Upgrading these
certificates to SHA-256 is not required.

For instructions, see the Help topic "Upgrade Internal Authentication Manager Certificates to SHA_256."
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Applying RSA Authentication Manager 8.1 SP1

On a hardware appliance or a VMware virtual appliance, you can apply SP1 to RSA Authentication Manager 8.1
with or without patches.

Note: RSA Authentication Manager 8.1 SP1 software is pre-installed on the Hyper-V virtual appliance.

RSA Authentication Manager 8.1 SP1 includes the software fixes in the cumulative Patch 5 for version 8.1. A
future patch for version 8.1 SP1 will include:

l Software fixes from the version 8.1 Patch 6

l Software fixes from any other 8.1 patches released before version 8.1 SP1

Applying SP1 removes any software fixes that are not included in the cumulative Patch 5 for version 8.1. You
must apply a future version 8.1 SP1 patch to obtain these fixes.

To apply SP1, perform these tasks in order:

1. Review the prerequisites. See Before Installing SP1 below.

2. Follow the standard steps to apply an 8.1 update. See Installing SP1 on the facing page.

3. If your deployment includes a web tier, you must update it using the Operations Console. See Update the
Web Tier on page 96.

Before Installing SP1

Before installing this upgrade, review the following guidelines and requirements.

Backup or VMware Snapshot Strongly Recommended
RSA Authentication Manager 8.1 Service Pack 1 is not reversible. If the service pack is not applied successfully,
you must restore from a backup file or a VMware snapshot. Trying to apply the service pack again is not
recommended.

Note: RSA strongly recommends backing up your deployment or taking a VMware snapshot before applying
Service Pack 1.

If you deployed a hardware appliance or a VMware virtual appliance, you can back up the version 8.1 database.
Use the Back Up Now feature in the Operations Console of the primary instance. See the Help topic “Create a
Backup using Back Up Now.”

You can restore version 8.1 if you backed up your deployment before applying Service Pack 1. See the Help topic
“Restore from Backup.”

If you deployed a VMware virtual appliance, you can take a snapshot of each virtual machine in the version 8.1
deployment.

When you take a snapshot of an Authentication Manager instance, you must specify the following settings:
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l Do not save the virtual machine’s memory.

l Choose to quiesce (disable) the guest file system. This option pauses running processes on the
Authentication Manager instance.

For additional instructions, see the VMware vSphere Client documentation.

You can restore version 8.1 if you took a VMware snapshot before applying Service Pack 1. Export your data or
take other steps to preserve your data before reverting to a snapshot. See the RSA Authentication Manager
Administrator's Guide for information about restoring snapshots.

Replicated Deployments
If you have a replicated deployment, all replica instances must be running and replicating successfully when
you apply SP1 to the primary or replica instances. All instances must be able to communicate while the upgrade
is applied. To verify the replication status, log on to the primary instance Operations Console, and then click
Deployment Configuration > Instances > Status Report.

Apply SP1 to the primary instance before upgrading the replica instances in your RSA Authentication Manager
8.1 deployment. On the primary instance, wait for the replication status to return to normal for all replica
instances before upgrading the replica instances.

Additional Requirements
SP1 has the following additional requirements:

l Each virtual appliance must have at least 4 GB of free disk space to apply SP1.

l The following credentials are required for the upgrade:

l Operating system password for the rsaadmin user account on each virtual appliance.

l An Operations Console administrator account, with access to the Operations Console, for the
primary instance and each replica instance.

Installing SP1

The RSA Authentication Manager 8.1 SP 1 ZIP file (am-update-8.1.1.0.0.zip) contains the following files:

l am-update-8.1.1.0.0.iso. The RSA Authentication Manager 8.1 SP1 ISO file that is used to apply the
service pack to Authentication Manager.

l RSA Authentication Manager 7.1 Migration Export Utility. The folder that contains the necessary
files for installing the updated Migration Export Utility on version 7.1. If you plan to perform amigration
from version 7.1, or are testing the version 7.1 migration process, use this version of the utility with
SP1. For more information, see one the following documents, as appropriate for your configuration:

l RSA Authentication Manager 7.1 to 8.1 Migration Guide: Upgrading RSA SecurID Appliance 3.0
on Existing Hardware

l RSA Authentication Manager 7.1 to 8.1 Migration Guide: Migrating to a New Hardware Appliance
or Virtual Appliance
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You can apply an update through your web browser, or you can store the service pack in an NFS share, a shared
folder on Windows, a DVD/CD, or an ISO image on your local machine.

The overall steps to install this service pack are as follows:

l Specify a Product Update Location below

l Scan for Updates on the facing page

l Apply the Product Update on page 94

Specify a Product Update Location
To specify a product update location, or to edit a previously specified location, perform the following procedure
to allow RSA Authentication Manager 8.1 to locate Service Pack 1.

If you have already specified a location, see Scan for Updates on the facing page.

Before you begin

l Download the service pack from RSA Link to a location that the primary or replica instance can access.

l If you intend to scan for updates on an RSA-supplied DVD or CD, do the following:

l On a hardware appliance, use the DVD/CD drive or mount an ISO image.

l On a virtual appliance, you must configure the virtual appliance to mount a DVD/CD or an ISO
image. See the Help topic “VMWare DVD/CD or ISO Image Mounting Guidelines.”

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. On the Update & Rollback page, your local browser is configured as the method for applying an update.
To change that setting, click Configure Update Source.

3. On the Configure Update Sources page, specify a location for updates.

l To upload the update from your local machine, select Use your web browser to upload an
update.

l To scan for updates on an NFS share, select Use NFS as the update source. Enter the full
path, including the IP address or hostname where updates are stored. For example:
192.168.1.2:/updates

l To scan for updates on a Windows shared folder, select Use Windows Share as the update
source.

l In theWindows Share Path field, enter the full path, including the IP address or
hostname where updates are stored. For example: \\192.168.1.2\updates

l (Optional) In theWindows Username field, enter a username. If your Windows share
configuration requires it, enter the domain and username.

92 Appendix C: Applying RSA Authentication Manager 8.1 SP1

https://community.rsa.com/community/products/securid


RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

l (Optional) In the Windows Password field, enter a password only if it is required by your
Windows share configuration.

l To scan for updates on a DVD or CD, select Use DVD/CD as the update source.

4. To test the NFS or Windows share directory settings, click Test Connection. A message indicates
whether the configured shared directory is available to the primary or replica instance.

5. Click Save.

After you finish

Do one of the following:

l If you configured your local web browser as the method to apply an update, see Apply the Product
Update on the next page.

l If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, see
Scan for Updates below.

Scan for Updates
If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, you can scan
to locate and review a list of available product updates.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. Click Scan for Updates. You can view the progress of the scan on the Basic Status View tab. You can
view more detailed information on the Advanced Status View tab.

3. Click Done to return to the Update & Rollback page.

The Available Updates section displays a list of updates, with the following information for each
update:

l Version. The version of the update. To see the current Authentication Manager version, see the
top of the Update and Rollback page.

l Reversible. Indicates whether you can roll back (undo) the update. Service pack 1 is not
reversible.

l Automatic Appliance Reboot. Indicates whether Authentication Manager automatically
restarts the Appliance to apply the update. If the Appliance restarts, you must perform another
scan to see a current list of updates.

l Automatic Operations Console Reboot. Indicates whether Authentication Manager
automatically restarts the Operations Console to apply the update. If the Operations Console
restarts, you must perform another scan to see a current list of updates.

l Action. States whether the update is available to apply. Lists the minimum system requirement
for the update.

4. In the Applied Updates section, click Download Detailed History Log for a complete update history.
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The Applied Updates section displays the updates applied to the instance. This section includes the
update version numbers, the time and date that each update was applied, and which administrator
applied the update.

After you scan for updates, the new list displays for 24 hours. Logging out of the Operations Console
does not remove the list from the system cache. If you restart the Operations Console, download
additional updates, or change the product update locations, you must perform another scan to see the
most current list.

After you finish

Apply Service Pack 1 to the RSA Authentication Manager deployment. See Apply the Product Update below.

Apply the Product Update
Apply the product update to the primary instance first, and then to each replica instance. As each replica
instance is updated, all of the accumulated data on each replica instance is sent to the primary instance.

Before you begin

l Ensure that port 8443/TCP is open for https traffic.

Access to this port is required for real-time status messages when applying Authentication Manager
patches and service packs.

During a product update, the appliance opens this port in its internal firewall. The appliance closes this
port when the update is complete.

If an external firewall blocks this port, the browser displays an inaccessible or blank web page, but the
update can successfully complete.

l Specify a Product Update Location on page 92

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update location,
Scan for Updates on the previous page.

l In a replicated deployment, after upgrading the primary instance, wait for the replication status to
return to normal for all replica instances before upgrading the replica instances. To verify the replication
status, log on to the primary instance Operations Console, and click Deployment Configuration >
Instances > Status Report.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. RSA recommends applying the most recent update. Do one of the following, depending on your
configuration:

l To apply an update through your local web browser, do the following:

a. Click Upload & Apply Update.

b. Click Browse to navigate to the location of the update. You cannot type the update
location in the Update Path field.
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c. Click Upload.

d. Verify the update details, and click Apply.

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update
location, do the following:

a. Click Scan for Updates. Available Updates displays all of the updates that can be
applied.

b. Next to the update to apply, click Apply Update.

c. Click Confirm to apply the update.

3. In the Password field, enter the password for the operating system user rsaadmin, and click Log On.

4. The basic status messages appear while the update is applied. You can view more detailed information
on the Advanced Status View tab.

Note: If the browser displays an inaccessible or blank web page, then port 8443/TCP might be blocked
by an external firewall. Real-time status messages are not available. Wait for the update to complete.

After the service pack is applied, the following occurs:

l The appliance automatically restarts. When the restart is complete, click Done.

l Authentication Manager moves the update from the Available Updates section to the Applied Updates
section.

l When you return to the Update & Rollback page, the update is listed in the Applied Updates section.
To save the high-level update history, click Download Detailed History Log.

l The software version information is updated with the service pack number. To view the software version
information, log on to the Security Console, and click Software Version Information.

After you finish

l You can download a detailed log file containing the information that was displayed on the Advanced
Status View tab. The file is named update-version-timestamp.log, where version is the update
version number and timestamp is the time that the update completed. For instructions, see the Help
topic “Download Troubleshooting Files.”

l After you have upgraded the primary instance and all of the replica instances, do the following:

l Verify that replication and radius replication is functioning correctly on the primary instance and
the replica instance.

l SP1 includes the software fixes in the cumulative Patch 5 for version 8.1. As needed, obtain later
software fixes by applying the latest version 8.1 cumulative patches to the upgraded
Authentication Manager instances.

l If the deployment includes a web tier, see Update the Web Tier on the next page.

Appendix C: Applying RSA Authentication Manager 8.1 SP1 95



RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

Update the Web Tier

You must update the web tier when you make any changes such as updating your version of Authentication
Manager and customizing the web-tier pages. Authentication Manager displays an update button in the
Operations Console for each web tier that is not up-to-date. If you have multiple web tiers to update, update one
web tier at a time. Each update can take up to 20 minutes to complete.

Procedure

1. In the Operations Console, click Deployment Configuration >Web-Tier Deployments > Manage
Existing.

2. On the Web Tiers page, in the Status column, click Update for the web tier that you want to update.

When the update is complete, the Status column for the updated web tier displays Online.
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Upgrading RSA Authentication Manager 8.0 to 8.1

TheRSA Authentication Manager 8.0 to 8.1 upgrade patch installs RSA Authentication Manager 8.1.

To install this upgrade, follow these procedures in order:

l Review the prerequisites. See Before Installing This Upgrade below.

l Follow the standard steps to apply version 8.0 or 8.1 patches:

l Specify an Upgrade Patch Location on page 100

l Scan for Updates on page 101

l Apply the Upgrade Patch on page 102

l Review the next steps that are specific to the upgrade.See After Installing this Upgrade on the Primary
and Replica Instances on page 103.

l If your deployment includes a web tier, you must reinstall it. See Reinstall the Web Tier on page 104.

Before Installing This Upgrade

Before installing this upgrade, review the following guidelines and requirements.

VMware Snapshot Strongly Recommended
The RSA Authentication Manager 8.0 to 8.1 upgrade patch is not reversible.

Note: RSA strongly recommends taking a VMware snapshot of each virtual machine before upgrading.

When you take a snapshot of an Authentication Manager instance, you must specify the following settings:

l Do not save the virtual machine’s memory.

l Choose the option to quiesce the guest file system in order to pause running processes on the
Authentication Manager instance.

For additional instructions, see the VMware vSphere Client documentation.

You can restore version 8.0 if you took a VMware snapshot before upgrading. Export your data or take other
steps to preserve your data before reverting to a snapshot. See the RSA Authentication Manager Administrator's
Guide for information about restoring snapshots.

Required Credentials
The following credentials are required:

l The upgrade requires the operating system password for the rsaadmin user account on each virtual
appliance.

l To apply the upgrade, you must have an Operations Console administrator account, with access to the
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Operations Console, for the primary instance and each replica instance.

l To reinstall the web tier, you must be a Super Admin.

Replicated Deployments
If you have a replicated deployment, all replica instances must be running and replicating successfully when
you apply the upgrade to the primary or replica instances. All instances must be able to communicate while the
upgrade is applied. To verify the replication status, log on to the primary instance Operations Console, and then
click Deployment Configuration > Instances > Status Report.

Apply this upgrade patch to the primary instance before upgrading the replica instances in your RSA
Authentication Manager 8.0 deployment. On the primary instance, wait for the replication status to return to
normal for all replica instances before upgrading the replica instances.

During the upgrade process, the upgraded version 8.1 primary instance and the existing version 8.0 replica
instances can successful replicate. Be aware that you cannot attach a new version 8.0 replica instance to a
version 8.1 primary instance.

Required Disk Space
Each virtual appliance must have free disk space that is equal to the size of the current Authentication Manager
database, plus 4 GB. For example, if the current database is 1 GB, then you need 5 GB of free disk space.

To determine the size of the current Authentication Manager database, log on to the appliance operating system
using SSH or the VMware vSphere Client, and then run this command:

dua -h -d 0 /opt/rs/am/rsapgdata

The command displays output that is similar to the following example:

64M     /opt/rsa/am/rsapgdata

Migrating From Version 7.1
Migrating from RSA Authentication Manager 7.1 to an upgraded version 8.1 deployment is not supported. If you
attempt to do this, migration fails, and the RADIUS dictionary files are deleted.

After upgrading from version 8.0 to version 8.1, you cannot do a full migration. You can only choose to import
data from version 7.1 while retaining the existing system settings and deployment topology. Migrate from
version 7.1 before applying the version 8.0 to 8.1 upgrade patch, or migrate from version 7.1 to a new version
8.1 deployment. To recover the RADIUS dictionary files, see the Knowledgebase article 000027979 at
https://community.rsa.com/community/products/securid/.

Patches for Version 8.0 and 8.1
RSA Authentication Manager 8.0 without patches or with any patch can be upgraded to version 8.1. The 8.0 to
8.1 upgrade kit installs the base version of 8.1, which includes the software fixes in the cumulative Patch 4 for
version 8.0.

If you have applied Patch 5, 6, 7, or 8 to version 8.0, then you should apply RSA Authentication Manager 8.1 SP1
after upgrading. Version 8.1 SP1 includes the software fixes in the version 8.0 Patches 5 through 8.

After upgrading to version 8.1 SP1, you can obtain the fixes included in later 8.0 patches by applying the latest
version 8.1 cumulative patch.
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Specify an Upgrade Patch Location

To specify a product update location, or to edit a previously specified location, perform the following procedure
to allow RSA Authentication Manager 8.0 to locate patches.

If you have already specified a location, see Scan for Updates on the facing page.

Before you begin

l Download the patch from RSA Link to a location that the primary or replica instance can access.

l To scan for updates on a DVD or CD, you must configure the virtual appliance to mount a DVD/CD or an
ISO image. See the Help topic “VMWare DVD/CD or ISO Image Mounting Guidelines.”

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. On the Update & Rollback page, your local browser is configured as the method for applying an
update. To change that setting, click Configure Update Source.

3. On the Configure Update Sources page, specify a location for updates.

l To upload the update from your local machine, select Use your web browser to upload an
update.

l To scan for updates on an NFS share, select Use NFS as the update source. Enter the full
path, including the IP address or hostname where updates are stored. For example:
192.168.1.2:/updates

l To scan for updates on a Windows shared folder, select Use Windows Share as the update
source.

l In theWindows Share Path field, enter the full path, including the IP address or
hostname where updates are stored. For example: \\192.168.1.2\updates

l (Optional) In theWindows Username field, enter a username. If your Windows share
configuration requires it, enter the domain and username.

l (Optional) In the Windows Password field, enter a password only if it is required by your
Windows share configuration.

l To scan for updates on a DVD or CD, select Use DVD/CD as the update source.

4. To test the NFS or Windows share directory settings, click Test Connection. A message indicates
whether the configured shared directory is available to the primary or replica instance.

5. Click Save.

After you finish

Do one of the following:
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l If you configured your local web browser as the method to apply an update, see Apply the Upgrade Patch
on the next page.

l If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, see
Scan for Updates below.

Scan for Updates

If you configured an NFS share, a Windows shared directory, or a DVD/CD as an update location, you can scan
to locate and review a list of available product updates.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. Click Scan for Updates. You can view the progress of the scan on the Basic Status View tab. You can
view more detailed information on the Advanced Status View tab.

3. Click Done to return to the Update & Rollback page.

The Available Updates section displays a list of updates, with the following information for each
update:

l Version. The version of the update. To see the current Authentication Manager version, see the
top of the Update and Rollback page.

l Reversible. Indicates whether you can roll back (undo) the update. The upgrade patch is not
reversible.

l Automatic Appliance Reboot. Indicates whether Authentication Manager automatically
restarts the Appliance to apply the update. If the Appliance restarts, you must perform another
scan to see a current list of updates.

l Automatic Operations Console Reboot. Indicates whether Authentication Manager
automatically restarts the Operations Console to apply the update. If the Operations Console
restarts, you must perform another scan to see a current list of updates.

l Action. States whether the update is available to apply. Lists the minimum system requirement
for the update.

4. In the Applied Updates section, click Download Detailed History Log for a complete update history.

The Applied Updates section displays the updates applied to the instance. This section includes the
update version numbers, the time and date that each update was applied, and which administrator
applied the update.

After you scan for updates, the new list displays for 24 hours. Logging out of the Operations Console
does not remove the list from the system cache. If you restart the Operations Console, download
additional updates, or change the product update locations, you must perform another scan to see the
most current list.

After you finish

Apply the upgrade patch to the RSA Authentication Manager deployment.
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Apply the Upgrade Patch

Apply the upgrade patch to the primary instance first, and then to each replica instance. As each replica
instance is updated, all of the accumulated data on each replica instance is sent to the primary instance.

Before you begin

l Specify an Upgrade Patch Location on page 100

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update location,
Scan for Updates on the previous page.

l In a replicated deployment, after upgrading the primary instance, wait for the replication status to
return to normal for all replica instances before upgrading the replica instances. To verify the replication
status, log on to the primary instance Operations Console, and click Deployment Configuration >
Instances > Status Report.

Procedure

1. In the Operations Console, clickMaintenance > Update & Rollback.

2. RSA recommends applying the most recent update. Do one of the following, depending on your
configuration:

l To apply an update through your local web browser, do the following:

a. Click Upload & Apply Update.

b. Click Browse to navigate to the location of the update. You cannot type the update
location in the Update Path field.

c. Click Upload.

d. Verify the update details, and click Apply.

l If you have configured an NFS share, a Windows shared directory, or a DVD/CD as an update
location, do the following:

a. Click Scan for Updates. Available Updates displays all of the updates that can be
applied.

b. Next to the update to apply, click Apply Update.

c. Click Confirm to apply the update.

3. In the Password field, enter the password for the operating system user rsaadmin, and click Log On.

4. The basic status messages appear while the update is applied. You can view more detailed information
on the Advanced Status View tab.

After the patch is applied, the following occurs:
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l Authentication Manager moves the update from the Available Updates section to the Applied Updates
section.

l The Operations Console or Appliance automatically restarts. When the restart is complete, click Done.

l When you return to the Update & Rollback page, the update is listed in the Applied Updates section.
To save the high-level update history, click Download Detailed History Log.

l The software version information is updated with the patch number. To view the software version
information, log on to the Security Console, and click Software Version Information.

After you finish

l You can download a detailed log file containing the information that was displayed on the Advanced
Status View tab. The file is named update-version-timestamp.log, where version is the update
version number and timestamp is the time that the update completed. For instructions, see the Help
topic “Download Troubleshooting Files.”

l Follow the steps in After Installing this Upgrade on the Primary and Replica Instances below.

l If the deployment includes a web tier, see Reinstall the Web Tier on the next page.

After Installing this Upgrade on the Primary and Replica Instances

After you have upgraded the primary instance and all of the replica instances, do the following:

l Verify that replication and radius replication is functioning correctly on the primary instance and the
replica instance.

l The upgrade installs the base version of RSA Authentication Manager 8.1, which includes the fixes in the
cumulative Patch 4 for version 8.0. As needed, obtain later software fixes by applying the latest version
8.1 patches to the upgraded Authentication Manager instances. For example, RSA Authentication
Manager 8.1 P01 will include the fixes in RSA Authentication Manager 8.0 P5, P6, and P7.

l If you upgraded an RSA Authentication Manager 8.0 deployment that did not have any patches applied,
then you should perform an additional step. RSA Authentication Manager 8.0 Patch 1 or later, and RSA
Authentication Manager 8.1 at any patch level, prevent the syslog from logging the operating system
password and the Simple Network Management Protocol (SNMP) passwords. To further secure these
passwords, do the following:

l Change the operating system account password and the passwords that are associated with your
SNMP configuration. For instructions, see the Help topics “Change the Operating System Account
Password” and “Configure SNMP.”

l Remove the operating system account password and the SNMP passwords from existing log
entries. For instructions, see the Knowledgebase article 000016875 at
https://community.rsa.com/community/products/securid/.
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Reinstall the Web Tier

If your deployment includes a web tier, after upgrading the primary and replica instances, you must upgrade
the web tier. Follow these procedures to retain all existing web-tier configuration and customization settings:

1. Uninstall the Web Tier below

2. Generate a New Web-Tier Deployment Package on the facing page

3. Run the Web-Tier Installer for Your Platform on the facing page

4. Update the Web Tier on page 106

Uninstall the Web Tier
Uninstalling a web tier removes the web tier and all features and components of RSA Authentication Manager
from the web-tier server. Uninstalling a web tier does not delete the web-tier deployment record.

For instructions, see the following:

Uninstall a Web Tier on Linux below

Uninstall a Web Tier on Windows below

Uninstall a Web Tier on Linux

During uninstallation, run the RSA Authentication Web-Tier Uninstaller for Linux on the web-tier server.

Before you begin

l Confirm that you have root privileges.

l Verify that the open files hard limit for the local user is at least 4096.

Procedure

1. Log on to the web-tier server.

2. Change directories to your-authentication-manager-web-tier-installation/uninstall.

3. On the command line, type:

./uninstall.sh

4. Press ENTER.

5. On the Welcome screen, type:

yes

6. Press ENTER.

The system uninstalls the web tier and displays “Uninstall Complete” when finished.

Uninstall a Web Tier on Windows

During uninstallation, run the RSA Authentication Web-Tier Uninstaller for Windows on the web-tier server.
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Before you begin

Confirm that you have Windows credentials to uninstall a program.

Procedure

1. On the web-tier server, go to Start > Control Panel > Programs and Features > Uninstall a
Program.

2. Right-click RSA Authentication Web Tier, and select Uninstall.

3. On the command line, type:

y

and press ENTER.

When finished, the uninstaller screen displays Uninstall finished.

4. Press ENTER.

The system removes the web-tier services and installation folders, except the top-level folder.

Generate a New Web-Tier Deployment Package
On the primary instance, generate a new web-tier deployment package. The web-tier deployment package
contains the information that Authentication Manager uses to connect the web tier to the preferred server.

Before you begin

You must be a Super Admin.

Procedure

1. In the Operations Console, click Deployment Configuration > Web-Tier Deployments > Manage
Existing.

2. If prompted, enter your Super Admin User ID and password.

3. From the list of web-tier deployment records, click a web-tier deployment record to generate the
package.

4. From the context menu, click Generate Package.

5. On the Generate Web-Tier Deployment Package page, verify the following information:

l Hostname of the web-tier server

l Preferred server hostname

6. Enter a web-tier package password.

7. Click Generate Package, and wait for the package to generate.

8. In the Download Web-Tier Deployment Package section, click Download Package.

Run the Web-Tier Installer for Your Platform
Obtain the RSA Authentication Manager 8.1 Extras download kit from RSA Download Central at
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https://download.rsasecurity.com. On the web-tier server, run the RSA Authentication Web-Tier Installer for
your platform. For instructions, see the following:

l Install a Web Tier on Windows Using the Graphical User Interface on page 61.

l Install a Web Tier on Windows Using the Command Line on page 63.

l Install a Web Tier on Linux Using the Graphical User Interface on page 64.

l Install a Web Tier on Linux Using the Command Line on page 65.

Update the Web Tier
You must update the web tier when you make any changes such as updating your version of Authentication
Manager and customizing the web-tier pages. Authentication Manager displays an update button in the
Operations Console for each web tier that is not up-to-date. If you have multiple web tiers to update, update one
web tier at a time. Each update can take up to 20 minutes to complete.

Procedure

1. In the Operations Console, click Deployment Configuration >Web-Tier Deployments > Manage
Existing.

2. On the Web Tiers page, in the Status column, click Update for the web tier that you want to update.

When the update is complete, the Status column for the updated web tier displays Online.

106 Appendix D: Upgrading RSA Authentication Manager 8.0 to 8.1

https://download.rsasecurity.com/


RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

Appendix E: Port Usage

Port Traffic 108

Ports for the RSA Authentication Manager Instance 108

Ports on the Web Tier with a Load Balancer Deployed 112

Ports on the Web Tier Without a Load Balancer 112

Access Through Firewalls 113

Appendix E: Port Usage 107



RSA Authentication Manager 8.2 SP1 Setup and Configuration Guide

Port Traffic

The following figure represents a common RSA Authentication Manager deployment with primary and replica
instances, web tiers, and a load balancer. An external firewall protects the primary and replica instances, and
another external firewall protects the DMZ. For more information on RADIUS ports, see Ports for the RSA
Authentication Manager Instance below.

Ports for the RSA Authentication Manager Instance

The RSA Authentication Manager instance has an internal firewall that limits traffic to specific ports. The internal
firewall restricts inbound traffic to the hosts and services that provide product functionality. Outbound traffic is
not restricted. RSA recommends that you deploy the instance in a subnet that also has an external firewall to
segregate it from the rest of the network.

The following table lists ports used by the Authentication Manager instance. Note the following:

l These ports are configured to be able to accept network traffic from remote systems. You should
configure these ports for access on your local network.

l Authentication Manager uses other, internal network connections for communication between
processes. Remote access to these ports is blocked by the internal firewall configured on the appliance.

l All ports support IPv4 only, unless IPv6 support is specified in the description.

Port
Number
and
Protocol

Function Source Description

22, TCP Secure Shell (SSH) SSH client Disabled by default. SSH can be enabled in the
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Port
Number
and
Protocol

Function Source Description

Operations Console. SSH allows the operating system
account (rsaadmin) to access the operating system.

49, TCP
TACACS
authentication

TACACS client
This port is closed unless TACACS is configured. Used to
receive authentication requests from a Network Access
Device (NAD).

80, TCP

Quick Setup

Operations Console,
Security Console

Administrator’s
browser

Used for Quick Setup. After Quick Setup is complete, the
appliance redirects connections from this port to the
appropriate console.

161, UDP SNMP SNMP client

Used by the Authentication Manager SNMP agent to
listen for GET requests and send responses to a Network
Management System (NMS).

This port is closed, unless SNMP is enabled. It can be
configured in the Security Console.

443, TCP

Quick Setup

Operations Console,
Security Console,
Self-Service Console

Administrator’s
browser

Used for Quick Setup. After Quick Setup is complete, the
appliance redirects connections from this port to the
appropriate console.

1645,
UDP

RADIUS
authentication (legacy
port)

RADIUS client

This port receives authentication requests from a
RADIUS client.

For more information, see Required RSA RADIUS Server
Listening Ports on page 112.

1646,
UDP

RADIUS accounting
(legacy port)

RADIUS client

This port receives inbound accounting requests from a
RADIUS client.

For more information, see Required RSA RADIUS Server
Listening Ports on page 112.

1812,
TCP

RADIUS replication
port

Another RADIUS
server

This port is used for communication between primary
RADIUS and replica RADIUS services.

If you do not use RSA RADIUS, but you have replica
instances, you must keep this port open. For more
information, see Required RSA RADIUS Server Listening
Ports on page 112.

1812,
UDP

RADIUS
authentication

RADIUS client

This port receives authentication requests from a
RADIUS client.

If you do not plan to use RSA RADIUS authentication, you
can close this port.

1813,
TCP

RADIUS
administration

RADIUS server

This port is used to administer RADIUS from the Security
Console over the protected RADIUS remote
administration channel.

If you do not use RSA RADIUS, but you have replica
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Port
Number
and
Protocol

Function Source Description

instances, you must keep this port open. For more
information, see Required RSA RADIUS Server Listening
Ports on page 112.

1813,
UDP

RADIUS accounting RADIUS client

This port receives accounting requests from a RADIUS
client.

If you do not plan to use RSA RADIUS authentication, you
can close this port.

5500,
TCP

Agent authentication
RSA SecurID
Authentication
protocol agents

Accepts requests from TCP-based authentication agents
and sends replies. Required for RSA SecurID and on-
demand authentication (ODA). This port supports both
IPv4- and IPv6-compliant agents.

5500,
UDP

Agent authentication
RSA SecurID
Authentication
protocol agents

Accepts requests from UDP-based authentication agents
and sends replies. Required for RSA SecurID, ODA and
risk-based authentication (RBA). This port only supports
IPv4-compliant agents.

5550,
TCP

Agent auto-
registration

RSA agents
Used for communication with authentication agents that
are attempting to register with Authentication Manager.

5580,
TCP

Offline authentication
service

RSA agents

Used to receive requests for additional offline
authentication data, and send the offline data to agents.
Also used to update server lists on agents.

This can be closed if offline authentications are not in
use and no agents in your deployment use the Login
Password Integration API.

7002,
TCP

SSL-
encrypted

Authentication
Manager

Another appliance

Used for communication between an Authentication
Manager primary and replica instances and for
communication between replica instances (for replay
detection).

Used by the RSA application programming interface
(API).

Enable if you have at least one replica instance.

7002,
TCP

SSL-
encrypted

RSA Token
Management snap-in
for the Microsoft
Management Console
(MMC)

Microsoft
Management
Console

Enable this port if you plan to use the RSA Token
Management snap-In to manage users and
authenticators from MMC.

7004,
TCP

SSL-
encrypted

Security Console
Administrator’s
browser

Required for administering your deployment from the
Security Console. Accepts requests for Security Console
functions.

7004, Self-Service Console User’s browser Required for using the Self-Service Console or RBA.
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Port
Number
and
Protocol

Function Source Description

TCP

SSL-
encrypted

and RBA
Accepts requests for Self-Service Console functions and
RBA authentication.

7004,
TCP

SSL-
encrypted

Cryptographic Token-
Key Initialization
Protocol (CT-KIP)

User’s browser Required for using dynamic seed provisioning.

7022,
TCP

SSL-
encrypted

Authentication
Manager, trusted
realm network access
point, or the web tier

Another appliance,
trusted realm, or
the web tier and
another appliance

Used for communication between Authentication
Manager primary and replica instances and for
communication between replica instances (for replay
detection).

Used to communicate with trusted realms.

Allows communication between the appliance and its
web tier.

7072,
TCP

SSL-
encrypted

Operations Console
Super Admin’s
browser

Required for administering your deployment from the
Operations Console. Accepts requests for Operations
Console functions.

7082,
TCP

SSL-
encrypted

RADIUS Configuration
SSL

Authentication
Manager instance

Used for configuring RADIUS and restarting the RADIUS
service from the Operations Console.

8443,
TCP

SSL-
encrypted

Authentication
Manager patches and
service packs

Administrator’s
browser

Access to this port is required for real-time status
messages when applying Authentication Manager
patches and service packs.

During a product update, the appliance opens this port
in its internal firewall. The appliance closes this port
when the update is complete.

If an external firewall blocks this port, the browser
displays an inaccessible or blank web page, but the
update can successfully complete.

Restricting Access to the RSA Consoles
Access to the Security Console (port 7004) and the Operations Console (port 7072) should be restricted to
internal administrators only. While port 7004 is used by the Security Console, dynamic seed provisioning, and
the Self-Service Console, it should not be directly accessible outside the intranet. To allow access to the Self-
Service Console or dynamic seed provisioning for external users, set up a web tier to help protect port 7004 and
restrict access to the Security Console.
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Required RSA RADIUS Server Listening Ports
RSA RADIUS is installed and configured with RSA Authentication Manager. All the RADIUS-related ports (1645,
1646, 1812, 1813, and 7082) on the Authentication Manager server are open by default.

The RADIUS standard initially used UDP ports 1645 and 1646 for RADIUS authentication and accounting
packets. The RADIUS standards group later changed the port assignments to 1812 and 1813. The
Authentication Manager RADIUS server listens on all four ports for backward compatibility. If all the RADIUS
clients are configured to talk to the RADIUS servers only on ports 1812 and 1813, you should block legacy ports
1645 and 1646 on the external firewall.

If you do not plan to use RSA RADIUS, but you have replica instances in your deployment, you must keep the TCP
ports 1812 and 1813 open on your network. These ports are required for tasks such as replica attachment,
replica promotion, and IP address and hostname changes. You can close the RADIUS authentication UDP ports
1812 and 1813.

Ports on the Web Tier with a Load Balancer Deployed

The following table lists the default listening ports on the web-tier server when a load balancer is installed in a
deployment.

If your environment has firewalls or proxy servers, make sure that they allow communication between the web
tier and all other hosts and services that provide Authentication Manager functionality. These hosts and
services, which are listed in the Source column, include Authentication Manager appliances, load balancers,
and browsers.

Port
Number
and
Protocol

Function Source Destination Description

443, TCP
Self-Service Console, risk-based
authentication (RBA), and dynamic
seed provisioning

User’s
browser

Primary
web-tier
hostname

Accepts requests for Self-Service
Console functions, RBA authentication,
and dynamic seed provisioning.

443, TCP RBA
Load
balancer

Web-tier
virtual
hostname

Accepts requests for RBA authentication
that use the virtual hostname.

Ports on the Web Tier Without a Load Balancer

The following table lists the default listening ports on the web-tier server when a load balancer is not used in
your deployment.

If your environment has firewalls or proxy servers, make sure that they allow communication between the web
tier and all other hosts and services that provide Authentication Manager functionality. These hosts and
services, which are listed in the Source column, include Authentication Manager appliances, load balancers,
and browsers.
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Port
Number
and
Protocol

Function Source Destination Description

443, TCP
Self-Service Console, risk-based
authentication (RBA), and dynamic
seed provisioning

User’s
browser

Primary
web-tier
hostname

Accepts requests for Self-Service
Console functions, RBA authentication,
and dynamic seed provisioning.

443, TCP RBA
User’s
browser

Web-tier
virtual
hostname

Accepts requests for RBA
authentication.

Note: Keep port 443 (or another port number if you change the default) open on the replica web tier, so that a
listening port is available.

Access Through Firewalls

RSA recommends that you set up all RSA Authentication Manager instances in a subnet that has an external
firewall to segregate it from the rest of the network. To enable authentication through external firewalls and to
accommodate static Network Address Translation (NAT), you can configure alias IP addresses for Authentication
Manager instances and alternate IP addresses for authentication agents. You can assign the following:

l Four distinct IP addresses (the original IP address and up to three aliases) to each Authentication
Manager instance. For instructions, see the Help topic “Add Alternative IP Addresses for Instances.”

l An unlimited number of alternate IP addresses (one primary IP address) to your agents. For
instructions, see the Help topic “Add an Authentication Agent.”

Each distinct IP address must be assigned to only one Authentication Manager instance. Authentication Manager
instances must not share an IP address, even if it is hidden by NAT.

You must know the primary IP address and aliases for each Authentication Manager instance. If your
deployment includes multiple locations, you must also know which ports are used for Authentication Manager
communications and processes. You may need to open new ports in your firewall, or clear some existing ports
for your deployment. Port translation is supported if the primary and replica instances are communicating on
the standard Authentication Manager ports. For example, the primary and replica instances must communicate
on port 7002, TCP. For more information on ports, see Port Traffic on page 108.

Securing Connections Between the Primary and Replica Instances
Authentication Manager uses port 7002 to replicate data between the primary and replica instance databases.
To secure this channel from unauthorized use, RSA recommends the following:

l If your deployment does not include a replica, or if your primary and replica instances are on the same
LAN, close port 7002 on your external firewall (not the appliance firewall) so that it does not pass
external traffic to the primary or replica instances.

l If your primary and replica instances are connected through a WAN and there is a firewall between
them, open port 7002 on the firewall, but restrict traffic on this port to originate only from the IP
addresses of the primary and replica instances.
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System Administrator Accounts

The following accounts provide permission to modify, maintain, and repair the Authentication Manager
deployment. Quick Setup creates these accounts with information that you enter. If you plan to record the logon
credentials for these accounts, be sure that the storage method and location are secure.

Authentication Manager Administrator Accounts
The following table lists the administrator accounts for Authentication Manager. The administrator who deploys
the primary instance creates these accounts during Quick Setup.

Name Permissions Management

Super Admin

Super Admins can perform all administrative tasks
in the Security Console with full administrative
permission in all security domains in the
deployment.

Any Super Admin can create other Super
Admin users in the Security Console. The
Super Admin also creates the security
domain hierarchy, and links identity sources
to the deployment.

An Operations Console administrator can
recover a Super Admin account if no Super
Admin can access the system.

Operations
Console
administrator

Operations Console administrators can perform
administrative tasks in the Operations Console.
Operations Console administrators also use
command line utilities to perform some procedures,
such as recovering the Super Admin account.
Command line utilities require the appliance
operating system account password.

Some tasks in the Operations Console also require
Super Admin credentials. Only Super Admins whose
records are stored in the internal database are
accepted by the Operations Console.

Any Super Admin can create and manage
Operations Console administrators in the
Security Console. For example, you cannot
recover a lost Operations Console
administrator password, but a Super Admin
can create a new one.

Operations Console administrator accounts
are stored outside of the Authentication
Manager internal database. This ensures
that if the database becomes unreachable,
an Operations Console administrator can
still access the Operations Console and
command line utilities.

User IDs for a Super Admin and a non-administrative user are validated in the same way. A valid User ID must
be a unique identifier that uses 1 to 255 ASCII characters.

A valid User ID for an Operations Console administrator must be a unique identifier that uses 1 to 255 ASCII
characters. The characters @ ~ are not allowed, and spaces are not allowed.

Note: Create an Operations Console administrator account for each Operations Console user. Do not share
account information, especially passwords, among multiple administrators.

Appliance Operating System Account
The appliance operating system account User ID is rsaadmin. This User ID cannot be changed. You specify the
operating system account password during Quick Setup. You use this account to access the operating system
when you perform advanced maintenance or troubleshooting tasks. The rsaadmin account is a privileged
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account to which access should be strictly limited and audited. Individuals who know the rsaadmin password
and who are logged on as rsaadmin have sudo privileges and shell access.

Every appliance also has a root user account. This account is not needed for normal tasks. You cannot use this
account to log on to the appliance.

You can access the operating system with Secure Shell (SSH) on a hardware appliance or a virtual appliance.
Before you can access the appliance operating system through SSH, you must use the Operations Console to
enable SSH on the appliance.

On a virtual appliance, you can access the appliance operating system with the VMware vSphere Client, the
Hyper-V System Center Virtual Machine Manager Console, or the Hyper-V Manager.

An Operations Console administrator can change the operating system account password, rsaadmin, in the
Operations Console.

RSA does not provide a utility to recover the operating system password.

Manage a Super Admin Account

Only a Super Admin can manage a Super Admin account.

Procedure

1. In the Security Console, click Identity > Users > Manage Existing.

2. Use the search fields to find the user that you want to edit.

3. Click the user that you want to edit and select Edit.

4. Update the user settings.

5. Click Save.
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Overview

The RSA Token Management snap-in provides a convenient way to manage RSA SecurID tokens for deployments
that have an Active Directory identity source. The RSA Token Management snap-in extends the context menus,
property pages, control bars, and toolbars in the Active Directory Users and Computers snap-in for the
Microsoft Management Console (MMC). You can use the RSA Token Management snap-in to enable or disable a
token, assign a token, or perform other token-related tasks without logging on to the Security Console. For more
information on the administrative actions enabled by this extension, see the RSA Token Management Snap-In for
the Microsoft Management Console Help.

System Requirements

You can install the RSA Token Management Snap-In on the following platforms:

l Windows Server 2012 R2 Domain Controller

l Windows Server 2012 R2 with the Active Directory Domain Services (AD DS) Snap-Ins and Command
Line Tools

l Windows Server 2008 R2 Domain Controller

l Windows Server 2008 R2 Server with the Active Directory Domain Services (AD DS) Snap-Ins and
Command Line Tools

l Windows Server 2008 Server with the Active Directory Domain Services Snap-Ins and Command Line
Tools

l Windows 7 with the with the Active Directory Domain Services Snap-Ins and Command Line Tools

Note: The RSA Token Management snap-in does not support Microsoft Active Directory Lightweight Directory
Services.

Windows Server 2012 R2 Active Directory includes the required .NET FrameWork 4.5 installation. For all other
supported platforms, you must install .NET 4.5 before installing the RSA Token Management Snap-In.

Install the Token Management Snap-In for Local Access

Use this procedure if you want to administer the Authentication Manager through the Token Management Snap-
In directly on the host where Active Directory is installed.

Before you begin

You must have the administrative permissions. These permissions (for example, domain level) depend on your
Windows network configuration. At minimum, you must be a domain administrator and a local machine
administrator.

Microsoft .NET 4.5 must be installed on the system where you update the Token Management Snap-In.
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Procedure

1. Obtain the RSA Token Management Snap-In installation files. The files are in the RSA Authentication
Manager 8.2.1 – Token Management Snap-In for MMC.zip file that you can download from RSA Link.

2. Unzip all of the installation files into a directory that is located on the samemachine where you are
installing the snap-in.

3. Do one of the following:

l If you have a 32-bit operating system, run setup32.exe.

l If you have a 64-bit operating system, run setup64.exe.

Note: The installer also installs the Visual C++ redistributable package if it is not already present.

4. Respond to the prompts forWelcome, Select Region, and License Agreement.

5. For Authentication Manager server settings, enter values for the following:

l Authentication Manager server hostname

l Authentication Manager server port number

l Command Server Port

6. When prompted for Destination Location, either accept the default location or enter an alternative
location.

7. Review the Pre-installation screen, and clickNext to continue.

8. Click Finish.

Install the Token Management Snap-In for Remote Access

Use this procedure if you want to administer the Authentication Manager through the Token Management Snap-
In remotely fromWindows 7 or a Windows Server 2008 or 2012 R2 without Active Directory.

Active Directory Domain Services (AD DS) Snap-Ins and Command Line Tools are part of the Remote Server
Administration Tools and are used for remotely managing Active Directory Domain Controllers fromWindows
Server 2012 R2, Windows Server 2008 R2, Windows Server 2008, or Windows 7 machines.

For Windows 7, you can perform remote administration using the Remote Server Administration Tools. This
tools package must be downloaded and installed separately, and can be installed only on Windows 7 (32-bit and
64-bit).

On Windows 2008 and Windows Server 2012 R2, the Remote Server Administration Tools feature is part of the
operating system and can be added from the Server Manager.

You can enable the AD DS Snap-Ins and Command Line Tools after installing the Remote Server Administration
Tools.
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Before you begin

l For Windows 7, download and install the Remote Server Administration Tools package from the Microsoft
web site.

l You must have the appropriate permissions. These permissions (for example, domain level) depend on
your Windows network configuration. At minimum, you must be a domain administrator and a local
machine administrator.

l The administrator using the AD DS Snap-In and Command Line Tools to remotely administer the Active
Directory must have appropriate administrative permissions. These permissions (for example, domain
level) depend on your Windows network configuration.

Procedure

1. Enable the AD DS Snap-Ins and Command Line Tools feature in Remote Server Administration
Tools.

2. Obtain the RSA Token Management Snap-In installation files. The files are in the RSA Authentication
Manager 8.2.1 – Token Management Snap-In for MMC.zip file that you can download from RSA Link.

3. Unzip all of the installation files into a directory that is located on the samemachine where you are
installing the snap-in.

4. Do one of the following:

l If you have a 32-bit operating system, run setup32.exe.

l If you have a 64-bit operating system, run setup64.exe.

5. Respond to the prompts forWelcome, Select Region, and License Agreement.

6. For Authentication Manager server settings, enter values for the following:

l Authentication Manager server hostname

l Authentication Manager server port number

l Authentication Manager Command Server Port

7. When prompted for Destination Location, either accept the default location or enter an alternative
location.

8. Review the Pre-installation screen, and clickNext to continue.

9. Click Finish.
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Performing Post-Installation Tasks

After a successful installation, perform the following tasks to complete the MMC Extension setup.

Procedure

1. Make sure that the Authentication Manager is set up and running.

2. Make sure that Active Directory is configured and registered as an identity source. For more information
see the Help topic "Identity Sources."

3. Start the Active Directory User and Computer Management Console below to open the RSA Token
Management Snap-In.

4. Configure the Connection with Authentication Manager below

5. Make sure that the Windows user for the Token Management Snap-In is a valid Active Directory
administrator and a valid Authentication Manager administrative user. For more information on
administrator and administrative permissions, see System Administrator Accounts on page 116.

Start the Active Directory User and Computer Management Console
To use the Token Management Snap-In for Authentication Manager administration, you must start the Active
Directory User and Computer Management Console.

Before you begin

Perform all of the preceding steps in Performing Post-Installation Tasks above.

Procedure

Do one of the following:

l Click Control Panel > Administrative Tools > Active Directory Users and Computers.

l From a command prompt, run dsa.msc.

Configure the Connection with Authentication Manager
You must specify connection settings such as server information and authentication information to enable the
Token Management snap-in to accessAuthentication Manager Server.

Before you begin

Perform all of the preceding steps in Performing Post-Installation Tasks above

Procedure

1. Access the Active Directory Users and Computers Management Console.

2. Click on any user. This makes the RSA button visible in the toolbar.

3. Click RSA in the toolbar.

The RSA Token Management Setting page is displayed.
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4. In the Server Information section, do the following:

a. In the AM Server Host field, enter the name of the machine on which RSA Authentication
Manager is running.

b. In the AM Server port field, enter the port number on which RSA Authentication Manager is
running.

c. In the Command Server Port field, enter the port number on which the Command Server is
running on the Authentication Manager Server.

5. In the Authentication Information section, do the following:

a. Select the UserID type for the user.

The format of the username displayed in the Login User field will be based on the chosen
UserID type.

Note: The UserID type must be the same as that defined for this identity source in the
Authentication Manager.
This user must be a member of the Domain Administrators group in Active Directory and must be
assigned Super Admin privileges in Authentication Manager.

b. In the User Password field, enter the user’s password.

c. Click Test Authentication to perform a test authentication.

If the UserID exists in more than one identity source, you can choose the identity source to test.
The chosen identity source will be displayed in the Identity Source Name field. When
prompted to use the certificate for future communication, click yes.
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